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Предисловие 
Благодарим Вас за приобретение этого изделия производства фирмы 
Topcon. Сведения, содержащиеся в этом руководстве (далее 
«руководстве») подготовлены фирмой Topcon Positioning Systems (далее 
«TPS») для владельцев изделий производства фирмы Topcon. Это 
руководство по эксплуатации было составлено для того, чтобы помочь 
использовать приемник при приведенных ниже условиях и положениях. 

 

Пожалуйста, внимательно ознакомьтесь с разделом 
“Условия и положения”. 

 

Условия и положения 
ПРОФЕССИОНАЛЬНОЕ ИСПОЛЬЗОВАНИЕ - Это изделие 
предназначено для профессионального использования. Пользователь 
должен иметь твердые навыки безопасной эксплуатации и соблюдать все 
меры безопасности, установленные органами охраны труда для частного 
использования и промышленности. 

АВТОРСКИЕ ПРАВА - Все содержимое этого руководства является 
интеллектуальной собственностью фирмы TPS и защищено авторским 
правом. Все права сохранены. Запрещается использовать, получать 
доступ, копировать, хранить, отображать, использовать для создания 
составительских работ, продавать, изменять, публиковать, 
распространять, либо позволять третьей стороне получать доступ к 
любым рисункам, содержимому, информации либо данным из этого 
руководства без письменного разрешения TPS. Перечисленное выше 
содержимое может использоваться только для обеспечения 
использования приобретенного изделия. Информация и данные, 
содержащиеся в этом руководстве, являются ценным активом TPS, при 
создании которого были понесены существенные затраты труда, времени 
и денежных средств и являются плодом собственных усилий TPS по 
подборке, выбору и систематизации.
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ТОВАРНЫЕ ЗНАКИ – GR-5TM, Topcon ToolsTM, Topcon LinkTM, TopSURVTM, 
Modem-TPSTM, Topcon® и Topcon Positioning SystemsTM являются 
товарными знаками или зарегистрированными торговыми марками TPS.  
Windows® является зарегистрированной торговой маркой Microsoft 
Corporation. Логотип Bluetooth® принадлежит Bluetooth SIG, Inc. и 
лицензирован Topcon Positioning Systems, Inc. Названия изделий или 
компаний, упомянутые в этом руководстве, могут быть товарными знаками 
соответствующих собственников. 

ОГРАНИЧЕНИЕ ГАРАНТИИ - ЗА ИСКЛЮЧЕНИЕМ ГАРАНТИЙНЫХ 
ОБЯЗАТЕЛЬСТВ И ЛИЦЕНЗИОННЫХ СОГЛАШЕНИЙ, ПРИЛАГАЕМЫХ К 
ИЗДЕЛИЮ И ПРИВЕДЕННЫХ В ПРИЛОЖЕНИИ К ЭТОМУ РУКОВОДСТВУ 
И НА ГАРАНТИЙНОЙ КАРТОЧКЕ, ПРИЛОЖЕННОЙ К ИЗДЕЛИЮ, ЭТО 
РУКОВОДСТВО И ИЗДЕЛИЕ ПОСТАВЛЯЮТСЯ “КАК ЕСТЬ”. 
ГАРАНТИЙНЫЕ ОБЯЗАТЕЛЬСТВА ДРУГОГО РОДА НЕ 
ПРЕДОСТАВЛЯЮТСЯ. ФИРМА TPS ОТКЛОНЯЕТ ЛЮБУЮ 
ПОДРАЗУМЕВАЕМУЮ ГАРАНТИЮ ТОВАРНОЙ ПРИГОДНОСТИ 
ИЗДЕЛИЯ ДЛЯ КАКОГО-ЛИБО КОНКРЕТНОГО ПРИМЕНЕНИЯ ИЛИ 
ИСПОЛЬЗОВАНИЯ. TPS И ЕЁ ПРЕДСТАВИТЕЛЬ НЕ НЕСУТ 
ОТВЕТСТВЕННОСТИ ЗА ТЕХНИЧЕСКИЕ ИЛИ РЕДАКТОРСКИЕ ОШИБКИ 
И ПРОПУСКИ, СОДЕРЖАЩИЕСЯ В ЭТОМ РУКОВОДСТВЕ, РАВНО КАК И 
ЗА УБЫТКИ СЛУЧАЙНЫЕ ЛИБО ЯВЛЯЮЩИЕСЯ ЗАКОНОМЕРНЫМ 
СЛЕДСТВИЕМ ПРИМЕНЕНИЯ, ИСПОЛЬЗОВАНИЯ ИЛИ 
ЭКСПЛУАТАЦИОННЫХ КАЧЕСТВ ЭТОГО РУКОВОДСТВА ИЛИ ИЗДЕЛИЯ. 
ТАКИЕ ОТКЛОНЯЕМЫЕ УБЫТКИ ВКЛЮЧАЮТ В СЕБЯ, НО НЕ 
ОГРАНИЧИВАЮТСЯ, ПОТЕРЯМИ РАБОЧЕГО ВРЕМЕНИ, УТЕРЕЙ ЛИБО 
ПОРЧЕЙ ДАННЫХ, УПУЩЕННОЙ ВЫГОДОЙ, ПОТЕРЯМИ ДЕНЕЖНЫХ 
СРЕДСТВ ЛИБО ДОХОДОВ, А ТАКЖЕ ПОТЕРИ ОТ ИСПОЛЬЗОВАНИЯ 
ИЗДЕЛИЯ. В ДОПОЛНЕНИЕ, TPS НЕ НЕСЕТ НИКАКОЙ 
ОТВЕТСТВЕННОСТИ И ОБЯЗАТЕЛЬСТВ ЗА УБЫТКИ ИЛИ ИЗДЕРЖКИ, 
ПОНЕСЕННЫЕ В СВЯЗИ С ЗАМЕНОЙ ИЗДЕЛИЯ ИЛИ ПРОГРАММНОГО 
ОБЕСПЕЧЕНИЯ, ИСКОВ ТРЕТЬИХ ЛИЦ, ВОЗМЕЩЕНИЯ НЕУДОБСТВ И 
ПРОЧИЕ РАСХОДЫ. В ЛЮБОМ СЛУЧАЕ TPS НЕ ДОЛЖНА НЕСТИ 
ОТВЕТСТВЕННОСТЬ ПО КОМПЕНСАЦИИ УБЫТКОВ ИЛИ РАСХОДОВ 
ПЕРЕД ВАМИ И ЛЮБОЙ ТРЕТЬЕЙ СТОРОНОЙ, ПРЕВЫШАЮЩУЮ 
ПРОДАЖНУЮ ЦЕНУ ПРИЕМНИКА. 

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ - Использование любого программного 
обеспечения («ПО»), поставляемого TPS, в том числе и загружаемого с 
интернет-сайта фирмы, должно производиться при принятии условий и 
положений, указанных здесь, и этого лицензионного соглашения. 
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Пользователю предоставляется персональное, неисключительное, не 
подлежащее передаче другому лицу разрешение использовать (лицензия) 
это ПО на указанных здесь условиях для одного изделия или одного 
компьютера. Вы не можете передавать или переуступать ПО или это 
разрешение без специального письменного разрешения TPS. Разрешение 
действует до его окончания. Вы можете прекратить действие лицензии в 
любой момент, уничтожив ПО и это руководство. TPS может прекратить 
действие лицензии в том случае, если Вы не выполняете любое из этих 
условий или положений. Вы должны уничтожить ПО и это руководство 
после того, как Вы прекратите использовать приемник. Все права 
собственности, авторские права и права на интеллектуальную 
собственность в ПО принадлежат TPS. Если Вы не согласны с 
вышеперечисленными условиями, предлагаем Вам вернуть не бывшие в 
употреблении руководство и ПО. 

КОНФИДЕНЦИАЛЬНОСТЬ - Это руководство, его содержимое и ПО 
(далее упоминаемые как «конфиденциальная информация») являются 
конфиденциальными, а информация является собственностью TPS. 
Принимая условия этого соглашения, Вы берете на себя обязательства 
сохранять эту информацию таким же образом, как наиболее ценные 
коммерческие секреты своей организации. Тем не менее, этот параграф 
не ограничивает Вас в предоставлении информации, нужной по роду 
деятельности Вашим работникам, занимающимся использованием и 
обслуживанием изделия. Таковые работники также обязаны не 
разглашать конфиденциальную информацию. В том случае, если вы 
будете вынуждены по закону раскрыть конфиденциальную информацию, 
Вы должны немедленно известить TPS с тем, чтобы мы могли 
ходатайствовать об охранном судебном приказе или соответствующих 
средствах правовой защиты. 

ИНТЕРНЕТ-САЙТ И ПРОЧИЕ ЗАЯВЛЕНИЯ - Данные условия и 
положения (в том числе лицензионное соглашение на ПО, ограничение 
гарантии и ограничения ответственности) не могут быть изменены 
заявлениями, опубликованными на Интернет сайте TPS (равно как и на 
любом другом Интернет сайте), в рекламных материалах и изданиях TPS, 
либо сделанные работником TPS или независимым подрядчиком TPS. 

МЕРЫ БЕЗОПАСНОСТИ - Неправильная эксплуатация изделия Topcon 
может быть причиной телесных повреждений, порчи собственности и/или 
отказа изделия. Ремонт изделия должен производиться исключительно в 
центрах гарантийного ремонта, авторизованных Topcon. Пользователям 
следует ознакомиться с предупреждениями о технике безопасности, 
приведенными в руководствах, приложенных к изделию, и строго им 
следовать. 
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РАЗНОЕ - упомянутые выше условия и положения могут быть в любой 
момент времени исправлены, изменены, заменены на другие, либо 
отменены фирмой TPS. Вышеупомянутые условия и положения 
соответствуют и должны толковаться в соответствии с законами штата 
Калифорния без использования других юридических норм. 

Соглашения, принятые в 
руководстве 
В этом руководстве использованы следующие обозначения: 

Обозначение  Описание  

File > Exit   Выберите пункт меню File (Файл), затем Exit  
    (Выход). 
Connection  Полужирным курсивным шрифтом выделено  
    название заголовков окон, в том числе диалоговых. 
Frequency  Курсивным шрифтом выделено название поля, 

 области или вкладки в диалоговом окне. 
Enter    Нажмите клавишу Enter (Ввод) клавиатуры. 

Примечание переводчика: названия отображаемых на английском языке 
элементов пользовательского интерфейса (названия пунктов меню, заголовков 
окон, кнопок, элементов списка и пр.) приведены в оригинальном виде, в скобках 
сразу за ними дан поясняющий перевод, пример см. выше.  

 

Дополнительные сведения о настройке и 
обслуживании системы 

 

  

Дополнительная информация, которая может помочь 
Вам при обслуживании и настройке системы. 

 
Дополнительная информация о факторах, которые 
могут оказать влияние на работу системы, ее 
технические характеристики, результаты измерений 
или личную безопасность. 
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Уведомление о том, что операция может оказать 
неблагоприятное воздействие на работу системы, ее 
технические характеристики, целостность данных 
или личное здоровье. 

 

 

Предупреждение о том, что операция повредит 
систему, вызовет потерю данных, потерю гарантии 
или вред здоровью. 

 

 

Предупреждение о том, что это действие нельзя 
выполнять ни при каких обстоятельствах. 
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Для заметок: 
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Глава 1  
Введение 
Спутниковый приемник GR-5 обеспечивает прием сигналов спутниковых 
навигационных систем и является наиболее современным и компактным 
устройством, предлагаемым для геодезических применений. Этот 
приемник многофункционален, универсален и предназначен для рынков 
высокоточных измерений. Под последним понимается рынок 
оборудования, систем, компонентов и программного обеспечения для 
съемки, строительства, коммерческого картографии, инженерного дела, 
высокоточного сельского хозяйства, контроля сельскохозяйственных и 
строительных машин, фотограмметрии, гидрографии и приложений, 
связанных с перечисленными выше. 
Приемник GR-5 может принимать и обрабатывать разнообразные типы 
сигналов, включая разработанные в последнее время GPS L2C, GPS L5, 
ГЛОНАСС ПТ L2 и GALILEO, повышая точность и надежность 
местоопределения, особенно в неблагоприятных условиях наблюдения. 
Прием сигналов в нескольких диапазонах от нескольких спутниковых 
систем позволяют обеспечивать точность определения координат для 
всех типов съемки. Дополнительные возможности, в том числе 
подавление влияния многолучевого распространения, обеспечивают 
прием слабых сигналов, даже под кронами деревьев. Приемник 
обеспечивает функциональность, точность, доступность и целостность, 
необходимые для быстрого и эффективного сбора данных. 

 
Рисунок 1-1. Приемник GR-5 
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Принцип действия 
Съемка, выполненная с помощью приемника GPS, может обеспечить 
точное и надежное местоопределение, что является обязательным 
условием для проведения всех видов геодезических работ. 
В этом разделе дается краткое описание функционирующих и 
планируемых к развертыванию Глобальных Навигационных Спутниковых 
Систем (GNSS-ГНСС) и работе приемника, чтобы помочь Вам понять и 
правильно применять эти знания на практике, что позволит Вам 
использовать приемник максимально эффективно. 

Обзор ГНСС 
В настоящее время услуги определения местоположения, скорости и 
времени предоставляют три глобальные навигационные спутниковые 
системы (ГНСС). Все эти системы всепогодные, работают круглосуточно и 
доступны в любой точке на поверхности Земли и в околоземном 
пространстве любому пользователю, имеющему приемник сигналов ГНСС. 

• GPS (Global Positioning System) – финансируется и управляется 
министерством обороны Соединенных Штатов Америки. Для 
получения информации о текущем состоянии системы посетите 
интернет-сайты обсерватории ВМФ США <http://tycho.usno.navy.mil/> 
и службы береговой охраны США (http://www.navcen.uscg.gov/). 

• ГЛОНАСС (Глобальная Навигационная Спутниковая Система) – 
финансируется и управляется министерством обороны Российской 
Федерации. Для получения информации о текущем состоянии 
системы посетите интернет-сайт Координационного Научного 
Информационного Центра (http://www.glonass-center.ru/frame_e.html). 

• GALILEO – система определения местоположения, развертываемая 
в настоящее время, финансируется и управляется Galileo Industries 
(Галилео Индастриз), совместным предприятием космических 
агентств нескольких европейских стран, тесно сотрудничающих с 
европейским космическим агентством. В отличие от GPS и 
ГЛОНАСС, эта система изначально предназначена для 
гражданского использования. В настоящий момент она находится на 
этапе проектирования и прототипирования. Для получения 
информации о текущем состоянии системы посетите интернет-сайт 
Galileo Индастриз (http://www.galileo-industries.net). 
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Несмотря на многочисленные различия технологического характера, все 
системы определения местоположения состоят из трех компонентов: 

• Космический сегмент – спутники GPS, ГЛОНАСС и Galileo 
обращаются по околокруговым орбитам высотой около 20 000 км 
над поверхностью Земли, снабжены радиопередатчиками и 
высокоточными хранителями времени. Каждый из этих спутников 
передает свои орбитальные параметры (эфемериды), альманах 
системы (параметры орбиты всех остальных спутников), параметры 
коррекции времени бортовых часов и другую информацию. 

• Сегмент управления – наземные измерительные пункты, 
расположенные в различных частях Земли, отслеживающие 
спутники и закладывающие в них данные о поправках бортовых 
часов и обновленные эфемериды для обеспечения достоверности 
передаваемой со спутников информации. 

• Пользовательский сегмент – гражданские и военные пользователи, 
оснащенные приемниками ГНСС, используют измерения, 
выполненные по этим сигналам для вычисления своего 
местоположения. 

Вычисление местоположения 
При вычислении местоположения движущийся или неподвижный 
приемник определяет пространственные координаты в трехмерной 
системе координат, связанной с центром масс Земли и неподвижной 
относительно нее. Чтобы определить свои координаты, приемник 
измеряет расстояния (называемые псевдодальностями в связи с тем, что 
хранитель времени приемника изначально не синхронизирован с 
общесистемной шкалой времени) до четырех или более спутников. В 
измеренные псевдодальности вносятся поправки за разность шкал 
времени спутника и общесистемной шкалы, предсказанные задержки из-за 
распространения сигнала в атмосфере и др. Положения спутников 
вычисляются по эфемеридам, передаваемым ими в навигационных 
сообщениях. При использовании одной спутниковой системы для 
определения координат необходимо не менее четырех спутников. При 
использовании нескольких систем (GPS, ГЛОНАСС, Galileo) приемник для 
получения местоположения должен принимать сигналы как минимум пяти 
спутников в связи с различиями временных шкал, используемых в этих 
системах. 
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Определение относительного 
(дифференциального) местоположения 
DGPS, или дифференциальная GPS – это методика определения 
относительного местоположения, в которой измерения, одновременно 
производимые двумя или более разнесенными в пространстве 
приемниками, обрабатываются совместно с помощью сложных 
алгоритмов, что позволяет определить относительные координаты 
фазовых центров антенн этих приемников с высокой точностью. 
DGPS реализуется разными способами, которые могут быть 
классифицированы по следующим параметрам: 

• По типу основных используемых измерений GNSS – задержка 
кодовой последовательности или отсчету фазы несущей. 

• Определяются ли результаты в реальном времени или при 
камеральной обработке. 

При работе в режиме DGPS один приемник, называемый опорным 
приемником или базовой станцией, размещается на пункте с известными 
координатами. Другой приемник, называемый удаленным или подвижным 
приемником, размещается на пункте, координаты которого требуется 
определить. Опорная станция производит измерения дальностей до всех 
доступных спутников и рассчитывает разности (поправки) между 
результатами этих измерений и дальностями, вычисляемыми по 
известным координатам точки стояния. 

• Для приложений реального времени эти поправки и координаты 
опорной станции затем приводятся к стандарту RTCM (или 
фирменным форматам передачи данных) - и передаются на 
удаленный приемник(и) с использованием канала передачи данных. 
Удаленный приемник использует собственные измерения и 
корректирует их принятыми поправками. 

• Для приложений с камеральной обработкой синхронные измерения, 
произведенные на опорных и подвижных станциях, обычно 
записываются на внутреннюю память приемника и не пересылаются 
по каналу передачи данных. После окончания сеанса измерений 
данные копируются в компьютер и обрабатываются совместно. 

При применении этой методики влияние искажающих изменения 
пространственно коррелированных факторов (например, погрешностей 
предсказания положений спутников, задержек при прохождении сигнала в 
ионосфере и тропосфере) могут быть существенно снижены, что приводит 
к повышению точности определения относительного местоположения. 
Существует несколько реализаций дифференциального способа 
определения координат, в том числе съемка с камеральной обработкой, 



Ознакомление 

P/N 7010-0736 1-5 

съемка в кинематическом режиме в реальном времени, съемка с 
использованием сигналов береговых радиомаяков, геостационарных 
спутников (например, сети OmniSTAR), а также системы спутникового 
дополнения (WAAS, EGNOS, MSAS). 
Наиболее точным методом съемки в реальном времени является метод 
RTK (кинематическая съемка в реальном времени). В этом методе 
используются, по крайней мере, два приемника и канал передачи данных 
между ними. Как правило, один из приемников (база) устанавливается над 
точкой с известными координатами, другой (подвижный) – над 
определяемой точкой. Базовый приемник производит измерения по фазе 
несущей частоты, вычисляет RTK-поправки и передает эти данные на 
подвижный приемник. Последний обрабатывает полученные данные 
вместе со своими собственными измерениями фазы несущей и 
определяет свое положение относительно базы с точностью до 1 см в 
плане и 1.5 см по высоте (для разных приемников эти показатели могут 
отличаться). 

Получение точного и надежного 
местоопределения 
Получение надежного и точного местоопределения возможно при 
соблюдении приведенных ниже условий: 

• Точность - точность местоположения зависит, прежде всего, от 
геометрии спутников (характеризуется геометрическим фактором 
ухудшения точности – GDOP) и погрешностей измерения дальности 
до спутников.  

- Дифференциальный режим GPS (DGPS и RTK) в значительной 
степени позволяет скомпенсировать погрешности, вызванные 
прохождением сигналов в атмосфере и неточностью 
предсказания орбит спутников и устраняет искусственное 
загрубение спутниковых сигналов, применяемое министерством 
обороны США. 

- Чем больше спутников в поле зрения и чем меньше величина 
геометрического фактора, тем выше точность 
местоопределения. 

• Доступность – доступность спутников влияет на достоверность 
вычисленного местоположения. Чем больше видимых спутников, 
тем выше точность и достоверность вычисления местоположения. 
Естественные и искусственные объекты могут блокировать, 
прерывать и ослаблять сигналы, снижая число видимых спутников и 
ухудшая условия приема сигналов. 

• Целостность – отказоустойчивость позволяет полагать, что 
местоопределение определяется надежно и точно. 
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Отказоустойчивость обеспечивается сочетанием перечисленных 
ниже факторов и методов: 

- Автономный контроль целостности приемником (RAIM) 
позволяет определить отказавшие спутники GNSS и исключает 
данные этих спутников из вычислений местоположения.  

- Наличие не менее пяти видимых спутников при работе по 
одному из созвездий GPS или ГЛОНАСС; не менее шести 
спутников при работе по обоим созвездиям. 

- Широкозонная дифференциальная подсистема (WAAS, EGNOS 
и др.) вырабатывает и передает наряду с дифференциальными 
поправками (DGPS), данные о целостности информации 
(например, сообщения о состоянии спутников).  

- Достоверные данные эфемерид и альманаха. 

Выводы 
В данном кратком обзоре приведены только основы местоопределения по 
спутниковым навигационным системам. Более подробную информацию 
можно найти на интернет-сайте TPS. 

Описание приемника 
При включении питания и завершении самотестирования приемника 216 
его каналов включаются и начинают отслеживать видимые над горизонтом 
спутники. Каждый из каналов приемника может быть использован для 
слежения за любым сигналом спутниковых навигационных систем GPS, 
ГЛОНАСС или GALILEO. Большое число каналов приемника позволяет 
вести слежение одновременно за всеми видимыми спутниками ГНСС в 
любом месте и в любое время 

Встроенная антенна GPS, оборудованная малошумящим усилителем, и 
высокочастотный тракт приемника соединяются с помощью коаксиального 
кабеля. Широкополосный сигнал преобразуется с понижением частоты, 
фильтруется, оцифровывается и распределяется по каналам слежения. 
Процесс приема сигнала контролируется процессором приемника. 
После распределения сигналов по каналам каждый сигнал 
демодулируется, и производится измерение его параметров (фаз кода и 
несущей частоты). Из сигнала выделяется передаваемый спутником поток 
данных. 
После приема сигналов от четырех или большего количества спутников 
определяются координаты приемника в системе WGS-84 и уход 
задающего генератора приемника от системной шкалы времени GPS. Все 
данные измерений можно сохранить на (поставляемой дополнительно) 
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карте памяти MMC (Multi-media Card) или SD (Secure Digital) и позже 
загрузить в компьютер для камеральной обработки с использованием 
соответствующего пакета программ. Когда приемник находится в режиме 
RTK, данные измерений также могут быть записаны на карту памяти 
приемника, что позволяет произвести контрольную камеральную 
обработку полевых измерений. 
Приемник обладает следующими функциями (некоторые следует 
заказывать специально): 

• Подавление многолучевости; 

• Прием сигналов спутников широкозонной системы улучшения 
местоположения (WAAS, EGNOS, и т.д.); 

• Настройка параметров петель слежения за фазой несущей (PLL) и 
кодовой задержки (DLL) 

• Одно- и многочастотные режимы съемки, включая статический, 
кинематический, кинематический в реальном времени (RTK) и 
дифференциальная GPS (DGPS) (режимы DGPS включают в себя 
статический, кинематический и RTK) 

• Автоматическая запись информации 

• Установка минимальных углов возвышения 

• Установка различных параметров съемки 

• Статические или динамические режимы 
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Ознакомление 
GR-5 - это 216 канальный приемник GPS с внешними съемными 
батареями, двумя интерфейсными портами, пользовательским 
интерфейсом, с помощью которого отображается процесс записи данных 
и осуществляется управление им, разъемом для подключения внешней 
карты памяти, внутренним радиомодемом, модулем беспроводной связи 
Bluetooth® и устанавливаемом по заказу модулем GSM/GPRS.  

Батареи 
Приемник GR-5 оборудован двумя съемными перезаряжаемыми 
батареями (см. рис. 1-2), с помощью которых осуществляется 
электропитание устройства.  

 
Рисунок 1-2. Батареи приемника GR-5 

Приемник питается от одной из батарей, после чего переключается на 
использование другой. Каждая съемная батарея обеспечивает 
(приблизительно) от четырех с половиной до восьми с половиной часов 
работы, в зависимости от текущего режима работы приемника. 
Блок подзарядки аккумуляторной батареи (см. рис. 1-3) подключается к 
стандартной розетке с помощью соединительного кабеля и блока питания. 
После подключения к сети переменного тока батареи заряжаются за 
шесть часов (приблизительно). После 500 циклов заряд-разряд батареи 
сохраняют не менее 80% начальной емкости. Эти батареи не следует 
предварительно полностью разряжать до очередной зарядки. 
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Блок подзарядки оснащен двумя портами, одной кнопкой и тремя 
светодиодами. 

• Два порта используются для подключения блока подзарядки либо к 
приемнику, либо к внешнему источнику питания. Порты заряжают 
или разряжают батареи одновременно. 

• Кнопка STATUS (СОСТОЯНИЕ) активирует светодиоды. 
Нажмите кнопку STATUS (СОСТОЯНИЕ), чтобы узнать уровень заряда 
батарей. 

• Два светодиода “Батарея” цветом отображают уровень заряда 
соответствующей батареи.  
- Зеленый - батарея заряжена более чем на 85%. 
- Желтый - у батареи средний заряд. 
- Красный - батарея заряжена менее чем на 15%. 

• Светодиод PWR (Питание) светится, если блок подзарядки 
подключен к внешнему источнику питания, например к блоку 
питания переменного тока или другому источнику питания 
(например, батарея на12 Вольт). 

 
Рисунок 1-3. Блок подзарядки со вставленными батареями 

Блок подзарядки батарей также можно прикрепить к штативу, поясу или 
вешке RTK для обеспечения внешнего источника питания для 
передвижной или базовой станции. 
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Отсек для батарей типа АА (см. рис. 1-4) содержит четыре батареи АА, 
что обеспечивает простое резервирование источника питания приемника. 
Время работы приемника зависит от емкости батареи АА, режима 
приемника и типа модема. 

 
Рисунок 1-4. Отсек для батарей типа АА в открытом положении 

Не используйте аккумуляторные батареи типа АА. 
Не используйте батареи типа АА, если радиомодем 
находится в режиме передатчика. 

 

Приемник GR-5 
Улучшенный дизайн приемника GR-5 уменьшает количество кабелей, 
необходимых для работы, позволяя вам проводить съемку более надежно 
и эффективно. В корпусе обеспечено место для подключения двух 
съемных аккумуляторных батарей, карт SD/MMC и SIM, а также 
содержится модуль беспроводной связи Bluetooth, плата многосистемного 
спутникового навигационного приемника и плата радиомодема. 
GR-5 выпускается в одной из следующих конфигураций: 

• с радиомодемом FH915 Plus TX/RX/RP (Прием/Передача/Репитер). 

• с радиомодемом FH915 Plus TX/RX/RP и модулем GSM/GPRS. 

• без радиомодема. 
Также в состав прибора входят два интерфейсных порта, порт питания и 
пользовательский интерфейс MINTER для отображения состояния 
приемника и контроля ввода/вывода данных. 
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MINTER 
MINTER-это пользовательский интерфейс приемника, предназначенный 
для отображения состояния и контроля ввода/вывода (см. рис. 1-5). 
Светодиоды батарей цветом отображают уровень заряда каждой 
батареи: 

• Зеленый - батарея заряжена более чем на 85%. 

• Желтый - у батарей средний заряд.  

• Красным - батарея заряжена менее чем на 15%. 
Светодиод STAT отображает состояние обнаруженных спутников. 

• Мерцает красным - приемник включен, но спутники не обнаружены. 

• Мерцает зеленым – приемник включен и обнаруживает спутники: 
одна вспышка на один спутник GPS 

• Мерцает оранжевым – приемник включен и обнаруживает спутники: 
одна вспышка на один спутник ГЛОНАСС 

 
Рисунок 1-5. MINTER приемника GR-5 
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Светодиод REC (Запись) отображает состояние записи данных. 
Подробное описание поведения этого светодиода при использовании 
кнопки FUNCTION см. в разделе “Кнопка FUNCTION” на стр. 1-13.  

• Вспыхивает зеленым цветом – каждое вспышка соответствует 
моменту записи на карту памяти SD/MMC. 

• Непрерывно светится оранжевым цветом – приемник изменяет 
режим работы.  

• Вспыхивает оранжевым цветом – показывает, что приемник 
проверяет свою внутреннюю файловую систему (после очищения 
NVRAM или загрузки нового программного обеспечения). Во время 
этой операции файловая система недоступна для программ 
дистанционного управления или для записи информации. Эта 
операция может потребовать от доли секунды до нескольких минут, 
в зависимости от условий и размера внутренней памяти. 

• Непрерывно светится красным цветом – отображает неисправность 
приемника (нехватка памяти, не вставлена SD/MMC карта, 
аппаратный отказ или неправильный OAF). 

Таблица 1-2 на стр. 1-14 описывает состояние светодиода REC (Запись) 
при использовании кнопки FUNCTION. 
Светодиод RX TX  отображает состояние модема. Таблица 1-1 описывает 
цвета светодиода и тип свечения для модемов, которыми может 
комплектоваться GR-5 

Таблица 1-1. Индикация светодиода RX TX  

Модем  
FH915 Plus 

• Не светится – модем выключен. 
• Зеленые вспышки - модем находится в режиме приема. 
• Непрерывное свечение зеленым цветом – сеанс 

радиосвязи открыт, приемник готов к приему данных. 
• Непрерывное свечение зеленым цветом и 

кратковременные красные вспышки – прием данных 
модемом. 

• Непрерывное свечение красным цветом – модем 
находится в режиме передачи. 

• Красные вспышки – обнаружен отказ модема. 
Проверьте состояние антенны радиомодема и 
убедитесь, что она не повреждена и подключена 
правильно и надежно. Также удостоверьтесь в том, что 
отсутствуют помехи. 

• Красные и зеленые вспышки - модем находится в 
режиме настройки.  
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GSM/GPRS 

• Непрерывное свечение оранжевым цветом (сочетание 
красного и зеленого) – модем запускается. 

• Зеленые вспышки – модем включен, зарегистрирован в 
сети и ждет входящий запрос (звонок) (подчиненный 
режим). 

• Непрерывное свечение красным – соединение 
установлено. 

• Зеленые вспышки - модем в режиме прямого 
управления. 

• Оранжевые вспышки – произошла ошибка (ошибка 
инициализации, неверный PIN код, и т. д.) 

Светодиод BT отображает состояние модуля беспроводной связи 
Bluetooth: 

• Синие вспышки – модуль Bluetooth включен, но соединение не 
установлено. 

• Непрерывное свечение синим цветом – модуль Bluetooth включен и 
соединение установлено. 

• Не светится - модуль Bluetooth выключен. 
Кнопка включения включает и выключает приемник. 
Кнопка FUNCTION (ФУНКЦИЯ) переключает приемник между режимами 
информации и записи данных, позволяет начать и остановить запись 
данных и позволяет установить скорость передачи данных по 
последовательному порту на стандартное значение 9600 Бод. Подробное 
описание см. в разделе “Использование MINTER” на стр. 4-7.  
Таблица 1-2 на стр. 1-14 описывает работу светодиода REC при 
использовании кнопки FUNCTION. 
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Таблица 1-2. Операции кнопки FUNCTION и состояние светодиода REC. 
Кнопка FUNCTION Светодиод REC Состояние 

Когда данные не записываются, и кнопка FUNCTION… 

Красный Нет свободной памяти, аппаратный 
отказ при записи данных. 

Режим кнопки FUNCTION – переключение режима 
светодиода 
Зеленый Запись данных началась (режим 

камеральной обработки не 
определен). 

Режим кнопки FUNCTION – изменение режима съемки 
Зеленый Запись данных началась (режим 

камеральной обработки - 
кинематический). 

Не нажата 

Оранжевый Запись данных началась (режим 
камеральной обработки - 
статический). 

Режим кнопки FUNCTION – переключение режима 
светодиода 
Оранжевый Режим сменится при отпускании 

кнопки. 
Режим кнопки FUNCTION – изменение режима съемки 

Нажата менее одной 
секунды 

Оранжевый При отпускании кнопки происходит 
смена режима со статического на 
кинематический и обратно. 

Нажата от одной до 
пяти секунд 

Не светится При отпускании кнопки запись 
данных прекращается. 

Нажата от пяти до 
восьми секунд 

Красный При отпускании кнопки для порта A 
устанавливается скорость обмена 
9600 Бод. 

Нажата более 
восьми секунд 

Не светится Действие не производится (данные 
записываются). 
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Таблица 1-2. Операции кнопки FUNCTION и состояние светодиода REC 
(продолжение). 

Кнопка FUNCTION Светодиод REC Состояние 

Когда данные записываются, и кнопка FUNCTION… 

Красный Нет свободной памяти, аппаратный 
отказ при записи данных. 

Режим кнопки FUNCTION – переключение режима 
светодиода 
Зеленый Запись данных началась (режим 

камеральной обработки не 
определен). 

Режим кнопки FUNCTION – изменение режима съемки 
Зеленый Запись данных началась (режим 

камеральной обработки - 
кинематический). 

Не нажата 

Оранжевый Запись данных начата (режим 
камеральной обработки - 
статический). 

Режим кнопки FUNCTION – переключение режима 
светодиода 
Оранжевый Режим сменится при отпускании 

кнопки. 
Режим кнопки FUNCTION – изменение режима съемки 

Нажата менее одной 
секунды 

Оранжевый При отпускании кнопки происходит 
смена режима со статического на 
кинематический и обратно. 

Нажата от одной до 
пяти секунд  

Не светится При отпускании кнопки запись 
данных прекращается. 

Нажата от пяти до 
восьми секунд 

Красный При отпускании кнопки для порта A 
устанавливается скорость обмена 
9600 Бод. 

Нажата более 
восьми секунд 

Не светится Действие не производится (данные 
записываются). 
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Интерфейсные порты и порт 
питания 
GR-5 оснащен тремя портами (см. рис. 1-6): 

• USB – (желтый ободок); предназначен для высокоскоростной 
передачи информации и соединения между приемником и внешним 
устройством.  
Корпус разъема на соответствующем кабеле желтый. 

• Последовательный (RS-232) – (черный ободок); предназначен для 
соединения между приемником и внешним устройством. 
Корпус разъема на соответствующем кабеле черный. 

• Порт питания – (красный ободок); предназначен для подсоединения 
приемника к внешнему источнику питания. Этот порт также можно 
использовать для подзарядки батарей. 
Корпус разъема на соответствующем кабеле красный. 

 
Рисунок 1-6. Порты приемника GR-5
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Разъем для подключения антенны 
радиомодема 
Антенна радиомодема подсоединяется к разъему, расположенному на 
обтекателе антенны GNSS в верхней части прибора (см. рис. 1-7). Тип 
разъема – reverse polarity TNC. 

 
Рисунок 1-7. Разъем антенны радиомодема, расположенный на обтекателе 

Разъем 
Нижний разъем (см. рис. 1-8) позволяет закрепить приемник на 
стандартном адаптере с резьбой 5/8” или к разъему быстрого 
подключения (подробнее см. «адаптер разъема быстрой установки» на 
стр. 1-21). 

 
Рисунок 1-8. Разъем быстрой установки GR-5 
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Слоты для SD/MMC и SIM карт 
Слоты для карт памяти MMC (multi-media card) / SD (secure digital) и SIM 
карт располагаются под батареями, рядом с основанием антенного 
обтекателя. 
Слот для SD/MMC карт расположен слева от MINTER, внутри выемки для 
батареи (см. рис. 1-9) и позволяет подключить карту к плате приемника 
для обеспечения дополнительной памяти. Установленная SD/MMC карта 
обычно остается внутри приемника. Информация, находящаяся на такой 
карте, доступна через USB или последовательный порт, а также по каналу 
беспроводной связи Bluetooth. Карта памяти может быть приобретена в 
вашем местном магазине компьютерных товаров.  
Слот для SIM карты расположен справа от MINTER, внутри выемки для 
батареи и через него в приемник может быть вставлена стандартная SIM 
карта. Вставленная SIM карта обеспечивает уникальный телефонный 
номер в сети сотовой связи стандарта GSM и позволяет приемнику 
пользоваться услугами этой сотовой сети (плата приемника обменивается 
данными с модулем GSM, а тот, в свою очередь, работает с SIM картой). 
SIM карта обычно остается внутри приемника. Модуль GSM со 
вставленной SIM картой настраивается с помощью программного 
обеспечения Modem-TPS. SIM карта приобретается (вместе с подпиской 
на услуги связи) у вашего местного оператора сотовой связи. 

 
Рисунок 1-9. Слот карты памяти приемника GR-5 
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Кабели 
Комплект GR-5 включает стандартные интерфейсные кабели и кабели 
питания, позволяющие настроить приемник и обеспечить его питанием. 
Таблица 1-3 перечисляет кабели, включенные в комплект GR-5. 

Таблица 1-3. Кабели, включенные в комплект GR-5 

Описание кабеля Внешний вид кабеля 
Кабель питания 
Подсоединяет блок питания к заземленной 
розетке. 
Для США p/n 14-008052-01 
Для Европы p/n 14-008054-01 
Для Австралии p/n 14-008053-01  

Кабель зарядки и питания приемника 
Подключает приемник и блок питания через 
соединителя SAE для зарядки батарей. 
Корпус разъема красный. 
p/n 14-008016-03  

Кабель блока подзарядки 
Подключает приемник к блоку подзарядки. 
p/n 14-008072-01 (длина 1.5 метра) 
p/n 14-008072-02 (длина 0.5 метра)  

Кабель USB 
Соединяет приемник с внешним устройством 
(контроллером или компьютером) для 
высокоскоростной передачи информации и 
настройки приемника. Корпус разъема желтый. 
p/n 14-008070-01 

 

Кабель последовательного порта 
Соединяет приемник с внешним устройством 
(контроллером или компьютером) для передачи 
информации и настройки приемника. Корпус 
разъема черный. 
p/n 14-008005-02  
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Прочие принадлежности 
Наряду с перечисленными ниже принадлежностями в комплект GR-5 
включаются: карта памяти SD емкостью 128 мегабайт, трехметровая 
измерительная рулетка, регулируемая по длине вешка и сумка для 
переноски кабелей. 
Блок питания (p/n 22-034101-01) заряжает внутренние батареи при 
подсоединении к заземленной розетке (см. рис. 1-10). Это устройство 
преобразует переменный ток сети электропитания в постоянный ток, 
используемый для зарядки батарей и питания приемника. 

Блок питания нужно использовать только для 
зарядки батарей. Не используйте как источник 
питания во время съемки. 

Блок питания может быть подсоединен к блоку подзарядки или напрямую 
к приемнику. Подробнее см. разделы, посвященные вопросам питания, в 
Главе 2. 

 
Рисунок 1-10. Блок питания 

Антенна радиомодема (p/n 30-030012-01) приемопередатчика сигналов с 
расширенным спектром поддерживает также рабочий диапазон модема 
GSM (см. рис. 1-11). Тип примененного на антенне разъема – reverse 
polarity TNC. 

 
Рисунок 1-11. Антенна модема 
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Стандартный трегер и адаптер трегера (p/n 22-006008-01 и p/n  
22-006009-011) используются для нивелирования головки штатива и 
крепления к нему приемника или антенны (см. рис. 1-12) 

 
Рисунок 1-12. Стандартный трегер с адаптером 

Адаптер быстрой установки (p/n 02-850905-01) устанавливается на 
вешку для обеспечения быстрого размещения на ней приемника. 
Используя боковые зажимы, приемник можно быстро установить на вешку 
и снять с нее (см. рис. 1-13). 

 
Рисунок 1-13. Адаптер быстрой установки 

Более подробную информацию о принадлежностях и вариантах 
комплектования, доступных для GR-5 Вы можете узнать, 
проконсультировавшись с вашим дилером Topcon. 
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Специально заказываемые 
принадлежности 
Topcon предлагает  широкий выбор  принадлежностей , предназначенных  
для  повышения  надежности  и увеличения  эффективности  Вашей  работы . 
Обратитесь  к вашему  дилеру  Topcon за  подробной  информацией  о 
принадлежностях , доступных  для  приемника  GR- 5. 

Адаптер точной установки трегера (см. рис. 1-14) предназначен  для  
точного центрирования , нивелирования  и установки  штатива  над  точкой. 
Втулка  (p/n 60419) вставляется  в адаптер  точной установки  трегера  и 
позволяет  надежно  закрепить  приемник. 

 
Рисунок 1-14. Адаптер точной установки трегера и втулка 

Портативный контроллер ( см. рис. 1-15) позволяет  настраивать  и 
управлять  непосредственно  в поле  базовыми  и подвижными  приемниками  
GR- 5. TopSURV ( программное  обеспечение  полевого сбора  данных ) и CE-
CDU ( программное  обеспечение  настройки  и управления  приемника ) могут  
быть  использованы  на контроллерах  Topcon для  настройки  и управления  
приемником . 

 
Рисунок 1-15. Портативные контроллеры
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Кабель “ODU на зажимы” (p/n 14-008097-01LF) позволяет подключить 
приемник или блок подзарядки к вспомогательной батарее для питания 
приемника при проведении съемки (см. рис. 1-13). 

 
Рисунок 1-16. Вспомогательный кабель питания “ODU на зажимы” 

Файл авторизации опций (OAF) 
Topcon Positioning Systems выпускает файлы авторизации опций (OAF) 
для того, чтобы пользователь получил возможность использовать 
приобретенные им опции. Файл авторизации опций (OAF) позволяет 
покупателям настраивать и конфигурировать приемник под выполнение 
конкретных задач, так что остается лишь приобрести необходимые опции. 
Обычно в поставляемый с завода приемник вносится временный OAF, 
который можно использовать только в установленный период времени. 
После поставки приемника заказчику новый OAF включает заказанные и 
оплаченные опции на постоянной основе. Возможности приемника 
остаются без изменений после очистки энергонезависимого ОЗУ или 
перезагрузке приемника. 
OAF предоставляет возможность воспользоваться следующими видами 
функций. Для получения полного списка возможных опций и их описания 
посетите сайт TPS или проконсультируйтесь с Вашим дилером Topcon. 

• Тип сигнала (стандартный – L1, дополнительные –  L2, L5 GPS, 
ГЛОНАСС, GALILEO). 

• Внешняя карта памяти SD. 

• Темп обновления данных (стандартно 1 Гц, дополнительно 5, 10 или 
20 Гц). 

• RTK в 1, 5, 10 и 20 Гц. 

• RTCM/CMR вход/выход. 

• Усовершенствованное подавление многолучевости. 

• Широкозонная дифференциальная подсистема (WAAS). 

• Контроль целостности автономным приемником (RAIM). 
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Для заметок: 
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Глава 2  

Подготовительные 
операции 
Перед началом съемки с помощью приемника GR-5 нужно установить 
следующие программы и произвести перечисленные ниже настройки: 

• Установите программу настройки приемника 
См. "Установка программ Topcon" на стр. 2-2. 

• Необязательная процедура: установка SD и/или SIM карты 
См. "Установка SD и SIM карт" на стр. 2-7. 

• Зарядите батареи 
См. "Зарядка батарей" на стр. 2-9. 

• Настройте использование источников питания (встроенного или 
внешнего) 
См. "Управление питанием" на стр. 2-10 и "Питание приемника" на 
стр. 2-14. 

• Настройте модуль беспроводной связи Bluetooth 
См. "Настройка модуля Bluetooth" на стр. 2-22. 

• Соберите альманахи и эфемериды (действия после проведения 
первой настройки описаны в главе 3). 
См. "Сбор альманахов и эфемерид" на стр. 2-26. 

В этой главе также описывается подключение батарей к приемнику, 
соединение приемника с компьютером и питание приемника с помощью 
различных источников. 
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Установка программ Topcon 
CD диск Topcon GPS+ включает следующие программы, используемые 
для настройки и управления приемником. Эти программы также доступны 
для зарегистрированных пользователей на сайте TPS. 

• PC-CDU Lite, версия 2.1.15 или более новая 

• Modem TPS, версия 2.0 или более новая  

• BTCONF, версия 1.2 или более новая  

• FLoader, версия 1.0.07 или более новая  
Для установки программ с CD диска GPS+ вставьте диск в привод CD-
ROM компьютера. При загрузке программ с Интернет сайта извлеките 
файлы программ в папку на жестком диске Вашего компьютера. 
Следующие разделы описывают установку этих программ, а их 
использование описывается в других разделах руководства. 

Установка программы PC-CDU 
PC-CDU™ - это программный продукт, работающий под управлением ОС 
Windows®, разработанный для управления приемниками производства 
фирмы Topcon. PC-CDU использует специализированный язык 
интерфейса приемника GPS (GRIL) для настойки разнообразных 
параметров приемника и контроля за его функционированием. 
Программа PC-CDU существует в двух версиях: полной - PC-CDU MS, и 
упрощенной - PC-CDU Lite. PC-CDU Lite доступна бесплатно на Интернет -  
сайте Topcon и CD диске GPS+. 
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию PC-CDU 2.1.15 или более новую. 

Обратитесь к справочному руководству PC-CDU для 
полной информации об установке и использовании 
PC-CDU. 
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1. Создайте папку PC-CDU на жестком диске и скопируйте в нее файл 
zip архива PC-CDU (полученный с Интернет сайта или CD диска 
GPS+). 

2. Перейдите в папку PC-CDU и дважды щелкните по файлу PC-
CDU.Zip. 

3. Извлеките PCCDU.EXE и присоединенный файл *.dll в папку PC-
CDU (см. рис. 2-1). 

4. Создайте ярлык на рабочем столе вашего компьютера для быстрого 
доступа к PC-CDU (см. рис. 2-1). 

 
Рисунок 2-1. Извлеките программу и создайте ярлык 

Для удаления PC-CDU откройте папку, содержащую файл *.exe. Выберите 
этот файл и нажмите кнопку Del клавиатуры. 

Установка программы Modem TPS 
Modem TPS – это программа, предназначенная для настройки для модуля 
радиомодема, смонтированного внутри приемника. Modem TPS доступен 
либо с сайта TPS, либо с CD диска GPS+. 
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию Modem-TPS 2.0 или более новую. 

1. Откройте папку, содержащую программу установки Modem TPS и 
два раза щелкните по иконке Setup.exe. 

2. Выберите место установки по умолчанию или новое. Щелкните на 
кнопке Finish.(см. рис. 2-2) 
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Рисунок 2-2. Выбор папки размещения и установка Modem TPS 

3. Щелкните на кнопке OK для завершения установки (см. рис. 2-3). 
4. Создайте ярлык на вашем рабочем столе (необязательно) для 

быстрого доступа к Modem TPS (см. рис. 2-3). 

 
Рисунок 2-3. Завершение установки и ярлык программы 

Для удаления Modem TPS используйте меню Пуск вашего компьютера: 
Щелкните Пуск > Все программы > Modem TPS > Удалить Modem TPS и 
нажмите Yes в появившемся сообщении. Затем щелкните на кнопке OK 
после окончания удаления программы. 

Установка программы BTCONF 
BTCONF – программа настройки модуля беспроводной связи Bluetooth, 
смонтированного внутри приемника. BTCONF доступен либо с Интернет 
сайта TPS, либо с CD диска GPS+.  
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию BTCONF 1.2 или более новую. 
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1. Создайте папку BTCONF на жестком диске и скопируйте в нее 
файл zip архива BTCONF, полученный с Интернет сайта или CD 
диска GPS+. 

2. Откройте папку BTCONF и дважды щелкните по файлу 
BTCONF.zip. 

3. Извлеките btconf.exe в папку BTCONF. 
4. Создайте ярлык на рабочем столе вашего компьютера для 

быстрого доступа к BTCONF (см. рис. 2-4). 

 
Рисунок 2-4.Извлечение программы и создание ярлыка 

Для удаления BTCONF откройте папку, содержащую файл *.exe. 
Выберите этот файл и нажмите Delete. 
При каждом запуске BTCONF и настройке модуля Bluetooth BTCONF 
сохраняет настройки в файле (btconf.ini). BTCONF автоматически 
обновляет файл каждый раз, когда вы изменяете настройки модуля 
Bluetooth. 

  

Чтобы сохранить уникальные настройки модуля 
Bluetooth для разных целей, сохраните копии 
BTCONF в отдельных папках. 
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Установка программы FLoader 
FLoader – утилита для перепрограммирования встроенного ПО платы 
питания, модуля GPS и платы радиомодема, размещенных внутри 
приемника. FLoader поставляется на CD диске GPS+. 
Минимальные системные требования: Windows®98 или более новая, RS-
232C или USB порт, либо Bluetooth. Для правильной настройки приемника 
используйте версию FLoader 1.0.07 или более новую. 

1. Создайте папку FLoader на жестком диске и скопируйте в нее файл 
zip архива FLoader, полученный с Интернет сайта или CD диска 
GPS+. 

2. Откройте папку FLoader и дважды щелкните по файлу FLoader.Zip. 
3. Извлеките FLoader.exe в папку FLoader (см. рис. 2-5). 
4. Создайте ярлык на рабочем столе вашего компьютера для быстрого 

доступа к FLoader (см. рис. 2-5). 

 
Рисунок 2-5. Извлечение программы и создание ярлыка 

Для удаления FLoader откройте папку, содержащую файл *.exe. Выберите 
этот файл и нажмите Delete. 
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Установка SD и SIM карт 
Под съемными батареями расположены слоты для SD и SIM карт. SD 
карта используется в качестве носителя для сохранения измерительных 
данных; SIM карта обеспечивает возможность установления телефонной 
связи между двумя приемниками, оборудованными модулями GSM. SD 
карта может быть приобретена в вашем местном магазине компьютерных 
товаров; SIM следует приобрести у местного оператора сотовой связи. В 
настоящий момент приемник поддерживает SD карты вместимостью до 
одного гигабайта. 
Вставленные карты обычно не вынимаются. Данные на карте доступны 
через USB или последовательный порт, либо с помощью канала 
беспроводной связи Bluetooth. 
Для установки SD карты (см. рис. 2-6): 

1. Удостоверьтесь в том, что приемник выключен. 
2. Выньте батарею, расположенную слева от MINTER. 
3. Осторожно вставьте SD карту наклейкой вниз в разъем для SD 

карты, расположенный в самом верху батарейной ниши. 

 
Рисунок 2-6. Установка карты SD 

Не вынимайте карту, если приемник включен. В 
результате неправильного извлечения карты 
данные, записанные на ней, могут быть утеряны. 
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После включения прибора плата приемника обнаружит SD карту и она 
будет готова к использованию. 
Для установки SIM карты (см. рис. 2-7): 
Для прямого соединения между двумя приемниками SIM карта должна 
поддерживать Circuit Switched Data (модемное соединение). Для 
соединения с IP-адресами сетевых GPS услуг SIM карта должна 
поддерживать GPRS. 

Для должного соединения SIM карту с поддержкой 
Circuit Switched Data и на базовом, и на подвижном 
приемниках следует подключить к услугам одного и 
того же оператора сотовой связи. 

1. Удостоверьтесь в том, что приемник выключен. 
2. Выньте батарею справа от MINTER. 
3. Вставите SIM карту в держатель. 
4. Осторожно вставьте держатель этикеткой вниз в разъем для SIM 

карты, расположенный в самом верху батарейной ниши. 

 
Рисунок 2-7. Установка SIM карты. 

После включения прибора плата приемника обнаружит SIM карту, и она 
будет готова к использованию. 
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Зарядка батарей 
Для обеспечения максимальной продолжительности работы батареи 
перед началом работы следует зарядить полностью (см. рис. 2-8 на стр. 2-
10). 

• Если батареи вставлены в блок подзарядки, то они будут заряжены 
в течение шести часов; обе батареи. 

• Если батареи вставлены в приемник GR-5, то они будут заряжены в 
течение шести часов; обе батареи заряжаются одновременно. 

Эти батареи не подвержены перезаряду. 

 

Батареи поступают с завода в разряженном 
состоянии. Полностью зарядите их перед началом 
съемки. 

Каждая съемная батарея может обеспечить от 4,5 до 8,5 часов работы 
(оценочное значение при комнатной температуре) в зависимости от 
режима работы приемника. 

  

Если батареи подключены к приемнику, для зарядки 
батарей подключите кабель блока питания к порту 
питания приемника. Батареи будут заряжаться 
одновременно. 

1. Выньте батареи из приемника и вставьте их в блок подзарядки. 
2. Подключите силовой кабель к блоку питания. 
3. Подключите соединители SAE к силовому кабелю и к блоку питания. 
4. Подключите кабель блока питания к одному из портов блока 

подзарядки (любой из портов обеспечит заряд обеих/каждой батарей). 
5. Подключите блок питания к розетке питания переменного тока. Полная 

зарядка батарей занимает примерно шесть часов. 
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Рисунок 2-8. Вставка батареи в блок подзарядки и подключение его к розетке 

После 500 циклов заряд-разряд у литий-ионных батарей, использованных 
в комплекте, должно оставаться не менее 80% от начальной емкости. Эти 
батареи не следует разряжать полностью до очередной подзарядки. 

Управление питанием 
Программа Topcon PC-CDU предоставляет возможность настройки, 
слежения за функционированием и управления приемником. 
Управление питанием приемника с помощью PC-CDU включает в себя 
выбор источника питания и режим заряда, а также отображение текущего 
заряда батарей. 

1. Подключите приемник к компьютеру. См. раздел "Подключение 
приемника к компьютеру" на стр. 2-19 для выполнения этой 
процедуры. 

2. После подключения выберите пункт меню Configuration > Receiver 
(Настройка > Приемник). 

3. В области Power (Питание) щелкните на выпадающем списке Mode 
(Режим) и выберите в нем нужный Вам источник питания (см. рис. 2-
9). Поле Current Mode (Текущий режим) указывает источник питания, 
используемый в настоящий момент; при использовании блока 
подзарядки там будет написано "extbat" (внешняя батарея).
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• Auto – выбор источника питания производится автоматически. 

• Mix (смешанный)– батареи разряжаются практически 
одновременно.  

• Battery A – обе батареи будут разряжаться в последовательности: 
сначала А, затем В, А, В и так далее. Таким образом, батарея В 
будет использоваться дольше на 1-2 часа. 

• Battery В – обе батареи будут разряжаться в последовательности: 
сначала В, затем А,В,А и так далее. Таким образом, батарея А 
будет использоваться дольше на 1-2 часа. 

 
Рисунок 2-9. Выбор режима питания 

4. В области Charger (Зарядное устройство) щелкните на 
выпадающем списке Mode (Режим) и выберите в нем нужный режим 
зарядки (см. рис. 2-10). Поле Current Mode (Текущий режим) 
указывает на заряжающуюся батарею: a, b или off (батареи не 
заряжаются). 

• Off – приемник не заряжает батареи 

• Auto - приемник автоматически обнаруживает необходимость 
подзарядки и заряжает обе батареи. 
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Рисунок 2-10. Выбор режима зарядного устройства 

5. В области Turn on/off (включение/выключение) щелкните на 
выпадающем списке Slots (Слоты, т.е. гнезда для внутренних 
плат) и выберите в нем нужный способ питания внутренних слотов 
(см. рис. 2-11). 

• On – слот С питается, лишь когда приемник включен 
• Off – внутренний слот не будет питаться, даже если включен 
приемник 

• Always – внутренний слот будет питаться, даже если приемник 
выключен 

 
Рисунок 2-11. Выбор подачи питания – слоты и порты 

6. В области Voltages (Вольтметры) (см. рис. 2-12) отображаются 
текущие значения напряжений:  

• External – внешнего источника питания. 
• On Board – выдаваемого платой питания. 
• Battery A – на батарее А. 
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• Battery В – на батарее В. 
• Charger – на зарядном устройстве при зарядке батарей. 

 
Рисунок 2-12. Отображение показаний вольтметров 

7. Флажок Enable Low Power Mode (Включить режим малого 
энергопотребления) позволяет перевести процессор приемника в 
режим малого потребления энергии (см. рис. 2-13). 

 
Рисунок 2-13. Установки режима питания 

8. Щелкните на кнопке Apply (Применить) 
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Питание приемника 
При питании от внутренних батарей приемник будет непрерывно 
переключаться с одной батареи на другую, поддерживая разницу в 0.4 
Вольт между батареями. 
Для проверки состояния внутренних батарей проконтролируйте 
светодиод BATT или воспользуйтесь программой Topcon. 

• Состояние светодиода BATT: 
− Зеленый цвет: заряд более 85%. 
− Оранжевый цвет: заряд менее 85% и более 15% 
− Красный цвет: заряд менее 15%. 

• Проделайте одно из перечисленных ниже действий в программе 
PC-CDU: 
− Выберите пункт меню Configuration > Receiver (Настройка > 

Приемник) для отображения напряжений на батареях в окне 
Receiver Configuration (Настройка приемника) 

− Выберите пункт меню Help > About (Помощь >О программе) 
для отображения показаний вольтметров в окне About PC-
CDU (о PC-CDU) 

Использование съемных батарей 
В комплект GR-5 входят две съемные перезаряжаемые батареи и отсек 
для батарей типа АА. Каждая батарея может обеспечить от 4.5 до 8.5 
часов работы при комнатной температуре в зависимости от текущего 
режима приемника и емкости батареи. 
Таблица 2-1. Приблизительное время работы при использовании двух полностью 

заряженных батарей. 

С использованием съемных батарей 
Состояние приемника: Bluetooth включен; обнаружено 10-12 спутников; 
комнатная температура 
Модем выключен 17 часов 

Модем 915+ только в режиме приема 13 часов 

Модем 915+ в режиме передачи 250 
милливатт 11 часов 

Модем 915+ в режиме передачи 1 ватт 9 часов 

С использованием отсека для батарей и батарей типа АА 
Состояние приемника: Bluetooth включен; обнаружено 10-12 спутников; 

Модем выключен 2.5 часа 
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Для установки батарей (см. рис. 2-14): 
1. Поместите низ батареи в низ батарейной ниши, придерживая 

батарею. 
2. Осторожно дошлите верхнюю часть батареи в батарейную нишу, до 

тех пор, пока она не окажется в нужном положении, о чем 
свидетельствует характерный щелчок. Удостоверьтесь в том, что 
зажим, расположенный вверху батареи, полностью занимает 
предназначенное для него место. 

 
Рисунок 2-14. Установка батарей в приемник GR-5 

Для извлечения батарей: 
Осторожно сдвиньте вниз зажим, расположенный вверху батареи, и 
выньте ее из ниши (см. рис. 2-15). 

 
Рисунок 2-15. Извлечение батарей из приемника GR-5 
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Для сборки отсека для батарей типа АА (см. рис. 2-16): 

Не используйте аккумуляторные батареи АА. 
Не используйте отсек для батарей типа АА для 
работы радиомодема в режиме передачи 

1. Сдвиньте заднюю крышку отсека для батарей типа АА вниз и выньте 
ее. 

2. Вставьте четыре батареи АА как показано внутри отсека (и на 
рисунке 2-16 ниже).  

• Батареи слева должны располагаться положительным 
полюсом к дну отсека. 

• Батареи справа должны располагаться положительным 
полюсом к верхней части отсека. 

3. Вставьте заднюю крышку отсека обратно. 

 
Рисунок 2-16. Снятие крышки и установка батарей типа АА 

4. Вставьте отсек для батарей типа АА в батарейную нишу приемника 
согласно раздела "Для установки батарей" на стр. 2-15. 
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Использование дополнительных 
источников питания 
В дополнение к съемным батареям приемник можно подключить к 
внешним батареям. Последние позволяют продолжить использование 
приемника после разрядки первых. 

 

Съемные батареи не заряжаются при питании от 
батарей, размещенные в блоке подзарядки. 
Энергия, поступающая из блока подзарядки, будет 
расходоваться исключительно на питание 
приемника. 

Для соединения приемника и блока подзарядки (см. рис. 2-17): 
Блок подзарядки с дополнительными батареями крепится на штатив или 
пояс для удобного питания приемника. Артикул кабеля соединения 
приемника с зарядным устройством – 14-008072-01 или 14-008072-02. 

1. Подсоедините один конец кабеля приемник-блок подзарядки к блоку 
подзарядки. 

2. Подсоедините другой конец к порту питания приемника. 

 
Рисунок 2-17. Соединение блока подзарядки и приемника 
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Для подключения приемника к запасной батарее (см. рис. 2-18): 
Используйте кабель “ODU на зажимы” (p/n 14-008097-01LF) для прямого 
подключения запасной батареи к порту питания приемника (без 
применения разъема SAE). 

При питании приемника от внешней батареи 
установите режим зарядного устройства Off, иначе 
съемные батареи также будут заряжаться, уменьшая 
время работы. Подробно установка режима 
зарядного устройства описывается в разделе 
“Управление питанием” на стр. 2-10. 

1. Подключите кабель “ODU на зажимы” к батарее на 12В. 
2. Подключите кабель“ODU на зажимы” к порту питания приемника. 
3. Включите приемник. 

 
Рисунок 2-18. Подключение дополнительной батареи к приемнику 

Одна внешняя батарея с напряжением в 12В, 2,3 А-час будет питать 
приемник с модемом 4,5 часа, а без модема – 6 часов. 
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Включение/выключение приемника 
Для включения приемника нажмите и удерживайте кнопку питания до 
кратковременной вспышки светодиодов. 
Для выключения приемника нажмите и удерживайте кнопку питания более 
одной и менее четырех секунд (до тех пор, пока не погаснут светодиоды 
STAT и REC). Упомянутая выше односекундная задержка препятствует 
случайному выключению приемника. 

Подключение приемника к 
компьютеру 
Программа Topcon PC-CDU предоставляет возможность настройки, 
слежения за функционированием и управления приемником. 
Настройки приемника, манипуляция с файлами и обслуживания 
приемника соедините приемник и компьютер с помощью одного из 
перечисленных ниже способов и запустите программу PC-CDU: 

• С помощью внешнего устройства, поддерживающего Bluetooth 
(компьютер/контроллер) 

• С помощью кабеля RS232 и компьютера/контроллера 

• С помощью кабеля USB и компьютера/контроллера 
Когда между приемником и компьютером/контроллером установлено 
соединение, вы сможете настраивать приемник и его компоненты, 
посылать команды приемнику, загружать файлы из памяти приемника; 
также вы сможете загружать новое программное обеспечение с помощью 
FLoader ™, загрузить OAF и загрузить в приемник файлы настройки.
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Беспроводное соединение 
Приемник GR-5 использует беспроводной канал связи Bluetooth, 
позволяющий передавать данные (файлы) между приемником и 
произвольным внешним устройством, поддерживающим Bluetooth – 
например, полевым контроллером FC-100 или компьютером с адаптером 
USB-Bluetooth либо адаптером PCMCIA-Bluetooth. 

Изменение настроек порта D приемника, принятых 
по умолчанию, повлияет на канал связи Bluetooth. 
Настройки порта D по умолчанию: 115200, 8, N, 1, 
квитирование не используется. 

Процедура соединения приемника с внешним устройством незначительно 
меняется в зависимости от типа используемого внешнего устройства. 
Общая процедура установления связи описана ниже. 

Обратитесь к справочному руководству вашего 
устройства, оснащенного Bluetooth, для получения 
подробной информации об установлении 
соединения. 

1. Включите поддерживающее Bluetooth внешнее устройство и 
приемник. Режим внешнего устройства по умолчанию – Ведущий 
(Master), режим Bluetooth приемника – Ведомый (Slave). 

2. Включите на внешнем устройстве (ведущем) поиск приемника 
(ведомого). 

3. После того, как ведущее устройство обнаружит приемник, 
проделайте действия, описанные в справочном руководстве 
внешнего устройства, чтобы подключить его к приемнику. 

4. Подключитесь к необходимой программе настройки (PC-CDU, 
Modem-TPS, и т.д.) следуя процедуре, описанной в разделах о 
настройке. 

Если вы не можете создать соединение, убедитесь в том, что разрешено 
использование третьего слота (внутреннего разъема) приемника. 

1. Подключите приемник к компьютеру с помощью кабеля RS232 или 
кабеля USB и воспользуйтесь программой PC-CDU (см. ниже). 

2. Выберите пункт меню Configuration > Receiver > General 
(Настройка > Приемник > Общие установки). 

3. В области Turn on/off (включение/выключение) выставьте флажок 
Slots 2 (С). 
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Соединение кабелем RS232 
1. Соедините последовательный порт компьютера (обычно COM1) с 

последовательным портом приемника. 
2. Нажмите кнопки питания на компьютере и приемнике, чтобы 

включить их. 
3. Подключитесь к необходимой программе настройки (PC-CDU, 

Modem-TPS, и т.д.) следуя процедуре, описанной в разделах о 
настройке. 

Соединение кабелем USB 
Убедитесь в том, что на компьютер установлен драйвер TPS USB, и что 
опция USB разрешена. 

1. Соедините порт USB вашего компьютера с USB портом вашего 
приемника с помощью USB кабеля. 

2. Нажмите кнопки питания на компьютере и приемнике, чтобы 
включить их. 

3. Подключитесь к необходимой программе настройки (PC-CDU) 
следуя процедуре, описанной в разделах о настройке. 
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Настройка модуля Bluetooth 
Программа BTCONF производства фирмы Topcon предназначена для 
настройки модуля Bluetooth и позволяет: 

• получить доступ к модулю Bluetooth. 

• настроить модуль Bluetooth. 

• проверить или изменить настройки модуля. 
Для доступа к модулю Bluetooth установите программу BTCONF на 
компьютер, затем установите соединение между компьютером  и 
приемником и запустите программу настройки. Подробнее см. раздел 
"Установка программы BTCONF" на стр. 2-4. 
После того, как программа BTCONF установлена, для настройки модуля 
Bluetooth проделайте следующие шаги: 

1. Соедините последовательный порт компьютера (обычно COM1) с 
последовательным портом приемника с помощью кабеля RS232. 
Включите приемник и компьютер. 

2. Запустите программу настройки модуля Bluetooth (см. рис. 2-19). 
Чтобы узнать версию BTCONF и данные об авторском праве, 
щелкните на кнопке About (О программе). 

 
Рисунок 2-19. Главное окно настройки модуля Bluetooth 



Подключение приемника к компьютеру 

P/N 7010-0736 2-23 

3. С помощью выпадающего списка в верхнем левом углу выберите 
последовательный порт компьютера, используемый для связи (см. 
рис. 2-20). 

4. Для соединения компьютера и модуля Bluetooth щелкните на кнопке 
Connect (Соединить). 

 
Рисунок 2-20 Выберите порт для связи и щелкните на кнопке Connect (Соединить) 

После того, как будет установлено соединение приемника и компьютера,  
во вкладке Identification (Идентификация), см. рис. 2-21, появятся 
следующие данные: 

• Bluetooth name – название модуля Bluetooth. 

• Bluetooth address – уникальный электронный адрес модуля. 

• Firmware version – текущая версия встроенного программного 
обеспечения модуля Bluetooth. 

 
Рисунок 2-21. Программа BTCONF. Вкладка Identification (Идентификация) 

Номер последовательного (COM) порта и скорость передачи данных 
отображаются в левом нижнем углу. 
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5. Выберите вкладку Parameters (Параметры) (см. рис. 2-22). В ней 
можно установить идентификатор (название) модуля. В области 
Security (Безопасность) устанавливаются параметры защиты от 
несанкционированного доступа. 

6. Введите уникальное название модуля Bluetooth длиной до 14 
символов (см. рис. 2-22) и щелкните на кнопке Apply (Применить). 

 
Рисунок 2-22. Программа BTCONF. Вкладка Parameters (Параметры) 

7. Установите перечисленные ниже параметры безопасности (см. рис. 
2-23 на стр. 2-25) и щелкните на кнопке Apply (Применить):  
• Bluetooth PIN (персональный идентификационный код Bluetooth) 

– введите для установления персонального идентификационного 
кода модуля Bluetooth (до 16 символов). 

• Encryption (шифрование) – если это поле выбрано, то по 
беспроводному каналу Bluetooth данные будут передаваться в 
зашифрованном виде. 

• Authentication (аутентификация, проверка подлинности) – если 
это поле выбрано, то соединение будет установлено только после 
предоставления вторым устройством PIN кода, введенного в поле 
Bluetooth PIN.  

Если Вы не хотите использовать защиту канала 
данных, оставьте перечисленные выше поля 
незаполненными. 
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Рисунок 2-23. Параметры защиты BTCONF 

8. Выберите вкладку Serial Interface (Последовательный интерфейс) 
(см. рис. 2-24). Выставьте флажок Echo (Эхо) если хотите, чтобы 
модуль Bluetooth посылал принятые символы обратно (полезно при 
доступе через терминальную программу). При необходимости 
щелкните на кнопке Apply (Применить) 

9. Для выхода из программы BTCONF щелкните на кнопке Disconnect 
(Отсоединить), затем Exit (Выход). 

 
Рисунок 2-24. BTCONF. Вкладка Serial Interface (Последовательный интерфейс)
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Сбор альманахов и эфемерид 
Каждый спутник передает навигационное сообщение, которое содержит 
эфемериды спутника, альманах и другую информацию. Эфемериды 
описывают положение спутника как функцию времени. По данным 
альманаха можно рассчитать грубое положение спутника, передавшего 
информацию, и всех спутников этой же системы. 

• Спутники систем GPS и ГЛОНАСС передают эфемериды 
циклически, с периодом 30 секунд. 

• Спутники системы GPS передают информацию альманаха 
циклически с периодом 12,5 минут; спутники системы ГЛОНАСС 
передают информацию альманаха циклически с периодом 2,5 
минуты. 

Если приемник обладает альманахом, то время, необходимое для поиска 
и захвата сигнала спутника, существенно уменьшается. 
Приемник регулярно обновляет альманах и эфемериды, сохраняя самые 
новые данные в своей энергонезависимой памяти (NVRAM). 
1. Установите приемник (соедините с внешней антенной, если это 

необходимо) в месте хорошего обзора небосвода. 
2. Включите приемник. 
3. Подождите примерно 15 минут, пока спутник собирает данные 

альманаха от спутников. 

Если 15 минут прошло, а приемник не захватил 
спутниковые сигналы, очистите энергонезависимую 
память (NVRAM). Эта процедура описана в разделе 
"Очистка энергонезависимой памяти (NVRAM)" на 
стр. 5-13. 

Следует собрать или обновить альманах и эфемериды при следующих 
условиях: 

• Если приемник был выключен в течение продолжительного 
периода времени. 

• Если последнее известное для приемника местоположение, 
сохраненное в энергонезависимой памяти (NVRAM), отличается от 
текущего местоположения на несколько сотен километров. 

• После загрузки нового OAF. 

• После загрузки нового программного обеспечения. 
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• После очистки энергонезависимой памяти (NVRAM). 

• Перед проведением съемки. 
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Для заметок: 
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Глава 3  
Настройка GR-5 
И базовый, и подвижный приемники следует настроить в зависимости от 
требуемого метода съемки. 

• В приложениях, где требуется получение данных о местоположении 
в реальном времени, базовый приемник вырабатывает поправки, 
необходимые для расчета точного положения подвижного 
приемника. 
Базовая станция обычно устанавливается на пункте с известными 
координатами и производит измерение параметров сигналов 
спутников GPS/ГЛОНАСС. Когда приемник собирает информацию со 
спутников, он измеряет фазу несущей частоту и задержку кода для 
вычисления и проверки собственного местоположения. Потом 
приемник передает данные измерений через радиоканал 
(радиомодем с расширенным спектром передачи или GSM) на 
подвижный приемник. 

• Подвижный приемник вносит поправки, полученные с базовой 
станции, в собственные измерения и определяет свое точное 
относительное местоположение.  
Подвижные приемники – это приемники GPS, монтируемые на 
съемочной вехе или двуногом штативе, которые сравнивают 
информацию с базовой станции с данными измерений со спутников, 
и применяют сложные алгоритмы для расчета собственного точного 
местоположения. 

• В приложениях, предназначенных для камеральной обработки, 
приемники обычно записывают сдвиг кода и отсчет фазы несущей 
частоты на общие моменты времени. Эта информация потом 
обрабатывается с помощью программ камеральной обработки 
(например, Topcon Tools) 
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При настройке приемников для съемки RTK сверьтесь с приведенным 
ниже перечнем для того, чтобы удостовериться в том, что приемники 
настроены правильно. 
□ Выполните подготовительные операции, описанные в главе 2. 
□ Настройте один приемник как базовую станцию RTK, а другой - как 

подвижный приемник RTK. См. "Настройка приемника" на стр. 3-10. 
□ Настройте канал передачи данных для передачи и приема поправок. 

• Для радиомодемов с расширенным спектром передачи см. раздел 
"Настройка радиомодема с расширенным спектром" на стр. 3-3. 

• Для модема GSM/GPRS см. раздел "Настройка радиомодема 
GSM" на стр. 3-7. 

□ Установите базовый приемник на известную точку для начала сбора 
информации статического сеанса измерений и передачи поправок. 
Используйте подвижный приемник для определения RTK 
местоположений. Подробнее см. раздел "Установка приемника" на стр. 
4-1. 

При настройке приемников для съемки с последующей камеральной 
обработкой сеансов измерений сверьтесь с приведенным ниже перечнем 
для того, чтобы удостовериться в том, что приемники настроены правильно. 
□ Выполните подготовительные операции, описанные в главе 2. 
□ Настройте один приемник как базовый, а другой - как подвижный. См. 

"Настройка приемника" на стр. 3-10. 
□ Установите базовый приемник на известную точку для начала сбора 

данных статического сеанса измерений. Используйте подвижный 
приемник для сбора данных статических или кинематических сеансов 
измерений. Подробнее см. раздел "Установка приемника" на стр. 4-1. 
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Настройка радиомодема 
Modem-TPS – это программа настройки радиомодемов, встроенных в 
приемники Topcon  Modem-TPS обеспечивает следующие возможности: 

• Подключение компьютера к интегрированному радиомодему 
через последовательный порт или беспроводной канал связи 
Bluetooth. 

• Отображение информации о радиомодеме, установленном в 
приемнике. 

• Программирование настроек радиомодема. 
Настройка приемника, оснащенного радиомодемом с расширенным 
спектром или GSM модулем с использованием Modem-TPS, описывается 
ниже. 

Обратите внимание на то, что одновременная 
работа SS радиомодема и модема GSM не 
допускается. В каждый момент времени можно 
использовать только один. 

 
Обязательно разорвите соединение до завершения 
работы программы Modem-TPS для предупреждения 
возможных конфликтов в доступе к  
последовательному порту после завершения 
настройки радиомодема. 

В программы Topcon для настройки и съемки TopSURV и Pocket 3D также 
обладают возможностями настройки приемников Topcon. Обратитесь к  
справочным руководствам TopSURV или Pocket 3D для более подробной 
информации. 

Настройка радиомодема с 
расширенным спектром 
Встроенный TPS радиомодем FH915+ реализует канал связи расширенным 
спектром (SS, spread spectrum) между базовым и подвижным приемниками. 
Для настройки SS радиомодема необходимо следующее оборудование: 

• Компьютер под управлением ОС Windows® 98 или более новой. 

• Установленная на компьютер программа Modem-TPS версии 2.0. 

• Кабель RS-232 (или поддержка беспроводной технологии 
Bluetooth). 

Настройка модуля GSM описана в разделе "Настройка радиомодема GSM". 
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1. Подключите приемник к компьютеру. Включите приемник. 
2. Запустите программу Modem-TPS и выберите последовательный 

(СОМ) порт подключения приемника (см. рис. 3-1). Щелкните на кнопке 
Connect (Соединить). 

 
Рисунок 3-1. Подключение Modem-TPS 

3. Во вкладке Radio Link (Радиоканал) установите перечисленные ниже 
параметры (см. таблицу 3-1) и щелкните на кнопке Apply (Применить) 
(см. рис. 3-2 на стр. 3-6). 

Таблица 3-1.Параметры приемника для вкладки радиосвязи 

Параметр Базовый приемник Подвижный приемник 

Protocol (Протокол) 

Выберите тип радио FH915 или FH915+ 
• Радиомодем FH915 может быть настроен как 

приемник или передатчик 
• Радиомодем FH915+ может быть настроен как 

приемник, передатчик или репитер. 

Location (Страна) 

Выберите страну, в которой будет использован 
приемник. 
При выборе Австралии будут применяться два 
поддиапазона для соответствия местным требованиям. 
Эта функция автоматическая и будет невидима для 
пользователя. 
Выберите Off (Выключен), если радио выключено; 
выберите Repeater (Репитер), если радиомодем 
способен выступать в этом качестве. Operation mode 

(Режим работы) Выберите Transmitter 
(Передатчик). 

Выберите Receiver 
(Приемник). 

Output power 
(Выходная мощность) 

Выберите режим передачи 
для радиомодема. Недоступно 

 
 
 

Выберите скорость передачи информации 
радиоканала. 
В отличие от скорости передачи по последовательному 
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Link Rate (Скорость 
передачи данных по 
радиоканалу). 
 
Для радиомодема 
FH915+ этот параметр 
устанавливается 
автоматически. 

кабелю, параметр “скорость передачи данных по 
радиоканалу” устанавливает темп передачи данных по 
эфиру. 
• 9600 –информационный пакет повторяется 3 раза; 

пакеты закодированы для уменьшения влияния 
помех. Это обеспечивает максимальную 
надежность передачи данных, но уменьшает 
пропускную способность. 

• 12000 –информационный пакет повторяется 5 раз; 
кодировка не применяется. 

• 17000 – информационный пакет повторяется 3 раза; 
кодировка не применяется. 

• 24000 – применяется только кодировка. 
• 51000 – не применяет повтора или кодировки. Это 

обеспечивает максимальную пропускную 
способность, но уменьшает надежность передачи 
данных. 

Для обеспечения максимальной эффективности размер 
блока данных, передаваемых радиомодему за единицу 
времени, не должен превышать скорость передачи 
данных по радиоканалу. При выборе скорости передачи 
данных по радиоканалу руководствуйтесь таблицей 3-2. 

Channel (Канал) 

Установите канал, который будет использоваться для 
передачи и приема данных. Каждый канал использует 
уникальную частоту, и это позволяет одновременно 
использовать до пяти радиосистем на одном участке. 
• Для обоих приемников в одной сети используйте тот 

же самый канал. 
• Для других сетей выберите другие каналы. 

Таблица 3-2. Скорость передачи данных по радиоканалу и последовательному 
порту 

Размер 
информационного 
пакета (в битах) 

Скорость 
передачи по 
RS-232 
(бит/с) 

Скорость 
передачи 
данных по 
радиоканалу 
(бит/с) 

Скорость приема по 
RS-232 (бит/с) 

0-9600 9600;19200 9600а;12000 9600;19200;38400;57600 
9600-12000 19200;38400 12000а;24000 19200;38400;57600 
12000-17000 19200;38400 17000а;24000 19200;38400;57600 

17000-24000 38400;57600 24000 38400;57600 

24000-51000 57600 51000 57600 
а) – рекомендованная скорость передачи данных для этого размера 
информационного пакета. 
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4. Во вкладке Serial Interface (Последовательный интерфейс) выберите 
перечисленные ниже параметры скорости передачи и щелкните на 
кнопке Apply (Применить) (см. рис. 3-2). 

• Baud Rate (Скорость передачи) – выберите скорость передачи 
последовательного порта модема. Для приемника и модема 
следует установить одинаковую скорость обмена. 

• Поле RTS/CTS устанавливает способ квитирования потока 
данных между приемником и модемом. Состояние "On" 
("Включено") разрешает применение аппаратного квитирования. 

Если скорость передачи данных по 
последовательному порту выше скорости передачи 
данных по радиоканалу, следует разрешить 
аппаратное квитирование для предотвращения 
потерь данных. 

 

 
Рисунок 3-2. Подтверждение параметров радиосвязи и скорости передачи 

5. По окончании выберите пункт меню File > Disconnect (Файл > 
Отсоединить). 

Настройка GSM радиомодема 
Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см 
от антенны GSM модуля. 

Плата встроенного в приемник GR-5 SS радиомодема, оборудованная 
модулем GSM, позволяет установить прямое соединение по сети сотовой 
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связи между базовым и подвижным приемниками или соединение по 
протоколу IP (Internet Protocol). Для настройки GSM радиомодема 
необходимо следующее: 

• Компьютер под управлением ОС Windows® 98 или более новой. 

• Установленная на компьютер программа Modem-TPS версии 2.0. 

• Кабель RS-232 (или поддержка беспроводной технологии 
Bluetooth). 

• Номер телефона базовой станции. 
1. Подключите приемник к компьютеру. Включите приемник. 
2. Запустите программу Modem-TPS и выберите последовательный 

(СОМ) порт подключения приемника (см. рис. 3-3). Щелкните на кнопке 
Connect (Соединить). 

 
Рисунок 3-3. Подключение Modem-TPS 

3. На вкладке GSM установите следующие параметры (см. таблицу 3-3) и 
щелкните на кнопке Apply (Применить) (см. рис. 3-4). 
Если некоторые поля отображают “N/A” ("Недоступно"), щелкните на 
кнопке Refresh (Обновить). 

Таблица 3-3. Параметры приемника для вкладки FCS 

Параметр Базовый приемник Подвижный приемник 

Mode (Режим) Выберите Slave (Ведомый). Выберите Master (Ведущий). 

PIN код Если требуется, введите Персональный Идентификационный 
Номер (PIN код). 

Dial (Номер) Оставьте незаполненным Введите телефонный номер 
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базового GSM модема 

Send time 
(Время 
отправки) 

Введите период времени (в секундах), во время которого 
базовый/подвижный GSM модем должен передать сервисное 
слово на подвижный удаленный/базовый GSM модем. 

• Этот параметр используется для поддержания 
надежного соединения между двумя модемами и для 
предотвращения ненужной перезагрузки модема. 

• Чтобы гарантировать надежное модемное соединение, 
этот параметр должен быть больше периода передачи 
дифференциальных поправок. 

Установите время отправки на ноль, если и базовый, и 
подвижный приемники – GR-5 со встроенными GSM 
модемами. 

 
Рисунок 3-4. Выбор GSM параметров для базового и подвижного приемников 

4. Для отображения данных информацию о модеме GSM щелкните на 
кнопке GSM info (Данные GSM) (см. рис. 3-5). Выбор кнопки Quit 
(Выход) осуществляет возврат к вкладке GSM. 
Поле Signal Quality (Качество сигнала) является отсчетом уровня 
сигнала GSM. Чем меньше число по абсолютному значению (обратите 
внимание на то, что отсчет уровня сигнала отрицателен) – тем лучше 
качество сигнала. Минимальный сигнал (отсечка) -111 дБ. 
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Рисунок 3-5. Отображение информации о модеме GSM 

5. Во вкладке Serial Interface (Последовательный интерфейс) выберите 
скорость обмена с модемом. Для приемника и модема следует 
установить одинаковую скорость обмена. 

6. По окончании выберите пункт меню File > Disconnect (Файл > 
Отсоединить). 

7. При необходимости запустите программу PC-CDU и настройте 
приемник в качестве базовой станции RTK. 
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Настройка приемника 
Приемник GR-5 можно настроить для работы в режиме RTK или сбора 
данных для камеральной обработки. 

• Статическая (неподвижная) базовая станция производит 
спутниковые измерения и сохраняет их во встроенной памяти. 

• Базовая станция RTK производит спутниковые измерения, 
вычисляет дифференциальные поправки и передает их на 
подвижные приемники. 

• Подвижная станция, работающая в режиме с последующей 
камеральной обработкой, производит спутниковые измерения по 
тому же созвездию и с тем же временным интервалом, что и 
статическая базовая станция и сохраняет их во встроенной 
памяти. 

• Подвижная станция RTK производит спутниковые измерения и 
использует принятые от базовой станции дифференциальные 
поправки для вычисления своего точного относительного 
местоположения. 

• Подвижная станция, выступающая в роли репитера, переизлучает 
в эфир принятые от базовой станции RTK поправки, и тем самым 
увеличивает зону покрытия базовой станции. 

Для настройки и обслуживания приемника, а также управления файлами, 
установите соединение между приемником и компьютером по одному из 
перечисленным ниже каналов связи и запустите программу PC-CDU. 

• Беспроводной канал Bluetooth. 

• Кабель последовательного интерфейса RS-232. 

• Кабель USB (заранее следует установить драйвер TPS USB, 
который предоставит поставщик оборудования). 

Программа PC-CDU (Personal Computer - Control Display Unit, терминал 
управления на ПК) предназначена для управления приемником. Полное 
описание возможностей этой программы выходит за рамки данного 
руководства. Более подробные разъяснения о порядке работы с 
программой PC-CDU приводятся в “Руководстве пользователя PC-CDU”, 
предоставляемом поставщиком оборудования. 

Программа PC-CDU позволяет настраивать разные узлы прибора, при этом 
настройки сохраняются в энергонезависимой памяти устройства. Установки 
влияют на интерфейс MINTER. Полное описание возможностей этой 
программы выходит за рамки данного руководства. 
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После установления связи между компьютером и приемником доступны 
следующие возможности: 

• Настройка приемника и его отдельных узлов. 

• Передача команд на приемник. 

• Выгрузка файлов из памяти приемника. 

• Загрузка нового OAF и прочих файлов настроек в приемник. 

Описанные ниже наборы настроек для базового и подвижного приемника 
рекомендуются для типовых применений. Однако, Вы можете вносить 
необходимые изменения в соответствии с конкретной обстановкой при 
выполнении работ. 

 

Любое изменение следует производить после 
тщательного изучения описания соответствующего 
параметра в “Руководстве пользователя PC-CDU”. 

1. Установите соединение между компьютером и приемником, действуя 
согласно указаниям раздела “Подключение приемника к компьютеру” на 
стр. 2-19. 

2. Запустите программу PC-CDU на компьютере. Внешний вид основного 
окна программы представлен на рис. 3-6. 

 
Рисунок 3-6. Основное окно программы PC-CDU 

Обратите внимание на то, что в нижнем левом углу исходное состояние 
приемника отображается как Disconnected (Не подключен). 

3. Выберите пункт меню File > Connect (Файл > Соединить). 
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4. В диалоговом окне Connection Parameters (Параметры 
интерфейсов) выберите указанные ниже параметры и щелкните на 
кнопке Connect (Соединить): 

Таблица 3-4. Параметры интерфейсов. 

Параметр RS-232 или Bluetooth USB 

Connection 
Mode (Режим 
Соединения) 

Выберите Direct (Прямое). 

Port (Порт) Выберите компьютерный порт, 
используемый для соединения 
(обычно COM1 или COM2 для 
интерфейса RS-232, COM3, 
COM4 и т.д. для Bluetooth) 

Выберите значение USB 

Baud Rate 
(Скорость) 

Выберите скорость обмена 
данными между приемником и 
компьютером (обычно 115200) 

Не указывается 

Rec ID (Номер) Не указывается Введите телефонный 
номер базового GSM 
модема 

 

 
Рисунок 3-7. Параметры соединения 
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После того, как программа PC-CDU установила соединение с 
приемником, текущие параметры соединения (название порта, скорость 
передачи данных (если применима для этого типа порта), способ 
квитирования) отображаются в левом нижнем углу основного окна 
программы. В правом нижнем углу размещен счетчик времени 
выполнения программы (см. рис. 3-8). 

 
Рисунок 3-8. Соединение программой PC-CDU установлено 

5. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник). 

Следует использовать кнопку Apply (Применить) 
после любого изменения параметров, в противном 
случае новые значения параметров в приемник не 
передаются.  

6. Щелкните на кнопке Set all parameters to defaults (Принять начальные 
значения для всех параметров), см. рис. 3-9. 

 
Рисунок 3-9. Принять начальные значения для всех параметров 
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7. Выберите вкладку MINTER и произведите установку параметров, 
перечисленных в таблице 3-5, после чего щелкните на кнопке Apply 
(Применить), см. рис. 3-10. 
Таблица 3-5. Параметры приемника, устанавливаемые во вкладке MINTER. 

Параметр Базовый приемник Подвижный приемник 

Recording interval 
(Период записи) 

Введите значение 15 секунд. 

Elevation Mask Angle 
(Минимальный угол 
места) 

Введите значение 15 градусов. 

File name prefix 
(Префикс названия 
файла) 

Введите уникальный идентификатор, например, три 
последние цифры серийного номера приемника. 

(начало/окончание записи данных по нажатию клавиши 
FN) 

FN key mode (режим 
клавиши FN) 

Для записи в статическом 
режиме выберите значение 
LED blink mode switch 
(Переключатель режима 
светодиода) 

Для записи данных RTK 
выберите значение 
Occupation mode switch 
(Переключатель режима 
съемки) 

Initial data collection 
dynamic mode 
(Исходная 
динамическая 
модель) 

Не указывается Выберите значение 
Kinematic 
(Кинематический), 
установка для 
траекторных измерений. 

 
Рисунок 3-10. Настройка записи данных MINTER 
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8. Выберите вкладку Positioning (Местоопределение) и установите 
значение поля Elevation Mask (Минимальный угол места) – 15 градусов 
(см. рис. 3-11), после чего щелкните на кнопке Apply (Применить). 

 
Рисунок 3-11. Установка минимального угла места 

9. Для базового приемника выберите вкладку Base (Базовый), 
произведите установку перечисленных ниже параметров (см. рис. 3-12 
на стр. 3-16), после чего щелкните на кнопке Apply (Применить). 
• Установите флаг GPS/GLO at one time (GPS и ГЛОНАСС 

одновременно). 
• Введите координаты антенны, Lat - широту, Lon – долготу и Alt – 

высоту одним из следующих способов: 
- Если они известны заранее, введите соответствующие 

значения. 
- Установите флажок Averaged (Осредненные) и введите 

значение Averaged Span (Интервал Осреднения), выраженный 
в секундах, после чего щелкните на кнопке Apply (Применить). 
Выберите пункт меню Tools > Reset receiver (Инструменты > 
Перезапуск приемника) и подождите, пока не пройдет 
заданный интервал времени. После этого координаты станции 
на вкладке Base должны соответствовать координатам, 
полученным после осреднения. Если координаты отображаются  
нулевые координаты, щелкните на кнопке Refresh (Обновить). 

- Щелкните на кнопке Get from receiver (Получить из приемника). 
Координаты антенны, задаваемые на этой вкладке, 
относятся к фазовому центру антенны в 
поддиапазоне L1. 

Для RTK съемок продолжите с шага 11 на стр. 3-17, а для съемок с 
камеральной обработкой – с шага 12 на стр. 3-18. 
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Рисунок 3-12. Настройка базовой станции 

10. При настройке подвижной станции (приемника) выберите вкладку Rover 
(Подвижный), произведите установку перечисленных ниже параметров 
(см. рис. 3-13 на стр. 3-17), после чего щелкните на кнопке Apply 
(Применить). 
• Positioning Mode (Режим местоопределения) для съемок с 

камеральной обработкой выберите значение Standalone 
(Автономный); для съемок RTK выберите RTK float (фазовая 
неоднозначность не разрешается до целых величин) или RTK fixed 
(разрешать неоднозначность измерения фазы до целой величины). 

• В области RTK Parameters (параметры RTK), поле RTK mode 
(режим RTK), выберите значение Extrapolation (Экстраполяция) для 
RTK float (кинематический режим) или Delay (задержка) для RTK 
fixed (статический режим). 
- Extrapolation (Экстраполяция) используется для RTK приложений 

с малой задержкой и высоким темпом (>= 5 Гц) выдачи данных. 
Подвижная станция будет экстраполировать поправки базовой 
станции по фазе несущей при вычислении своего текущего 
местоположения. 

- Delay (Задержка) применяется для высокоточных RTK 
приложений с периодом обновления места 1 раз в секунду. 
Вычислитель подвижной RTK станции будет вычислять либо RTK 
местоположение с задержкой (на эпоху, к которой относится 
последнее полученное сообщение RTCM/CMR), либо текущее 
автономное местоположение (в процессе ожидания новых 
RTCM/CMR сообщений, приходящих от базовой станции). 

• В области RTK Parameters (параметры RTK), поле Dynamics 
(Динамика объекта), выберите значение Static (Неподвижный) или 
Kinematic (Движущийся). 
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• В области RTK Parameters (параметры RTK), поле Ambiguity fixing 
level (Управление процессом разрешения неоднозначности 
измерения по фазе несущей), для режима RTK Float этот параметр 
не используется. Выбор этого параметра определяет величину 
доверительного интервала, который служит критерием для принятия 
решения о правильности разрешения неоднозначности по фазе. 
Значение Low (Низкий) соответствует 95%, Medium (Средний) - 
99,5% и High (Высокий) - 99,9%. Чем выше уровень доверительного 
интервала, тем больше время разрешения целочисленной 
неопределенности (и надежнее полученное местоопределение). 

 
Рисунок 3-13. Настройка подвижного приемника 

Для RTK съемок продолжите с шага 11, а для съемок с камеральной 
обработкой – с шага 12 на стр. 3-18. 

11. Для RTK съемок выберите вкладку Ports (Порты) и установите 
параметры последовательного порта (см. Табл. 3-6), после чего 
щелкните на кнопке Apply (Применить), см. рис. 3-14 на стр. 3-18. 

Для съемок с камеральной обработкой оставьте 
значения этих параметров заданными по умолчанию.

Таблица 3-5. Параметры приемника, устанавливаемые во вкладке Ports. 

Параметр Базовый приемник Подвижный приемник 

Input (Вход) Не применимо (оставьте 
значение по умолчанию). 

Выберите тот же формат 
дифференциальных 
поправок, что и на базовой 
станции. 

Output (Выход) Выберите формат и типы 
дифференциальных поправок 

Выберите значение “None” 
("Отсутствует”). 
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Таблица 3-5. Параметры приемника, устанавливаемые во вкладке Ports 
(продолжение). 

Параметр Базовый приемник Подвижный приемник 

Period (sec) 
(Период выдачи 
поправок [c]) 

Задайте период выдачи 
дифференциальных поправок. 

Не применимо (оставьте 
значение по умолчанию). 

Baud Rate 
(Скорость 
передачи) 

Выберите скорость последовательного порта, по которому 
плата приемника выдает дифференциальные поправки на 
плату модема. 
Скорость следует установить равной скорости 
последовательного порта модема. 

RTS/CTS Выставьте флажок для разрешения аппаратного 
квитирования.  

 
Рисунок 3-14. Настройки портов для базового и подвижного приемников при RTK 

съемке 
12. Выберите вкладку Advanced (Расширенные функции), затем вкладку 

Multipath Reduction (Подавление многолучевости), выставьте 
перечисленные ниже флажки и щелкните на кнопке Apply (Применить) 
(см. рис. 3-15 на стр. 3-19). 
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• Code multipath reduction (подавление многолучевости в измерении 
по коду). 

• Carrier multipath reduction (подавление многолучевости в измерении 
по фазе несущей). 

 
Рисунок 3-15. Настройка параметров подавления многолучевости 

13. Щелкните OK для сохранения изменений и закройте окно. 
После настройки приемника настройки сохранятся, пока вы не измените их 
с помощью PC-CDU/TopSURV/Pocket-3D или очистив  NVRAM. 
Для получения подробной информации о доступных настройках для 
Базовых и Удаленных приемников, обратитесь к справочному руководству 
PC-CDU. 
14. Продолжите выполнение других действий настройки или щелкните File 

> Disconnect (Файл > Отсоединить), а затем File > Exit (Файл > 
Выход), чтобы покинуть PC-CDU. Разъединение перед выходом 
гарантирует надлежащее управление портом. 

Перед окончанием работы программы следует 
разорвать соединение между приемником и PC-CDU. 
Это поможет избежать конфликтов в управлении 
последовательными портами компьютера. 



Настройка GR-5 

 GR-5. Руководство пользователя 3-20 

Настройка MINTER 
MINTER (Minimum INTERface - минимальный интерфейс) состоит из двух 
кнопок, Питание и FUNCTION (Функция), управляющих работой приемника, 
четырех светодиодов (STAT, REC, BATT и RX) отображающих состояние 
приемника и двух светодиодов, отображающих состояние батарей (см. рис. 
3-16). 

 
Рисунок 3-16. Интерфейс MINTER 

С помощью MINTER можно осуществить перечисленные ниже действия 
(подробнее см. раздел “Использование MINTER” на стр. 4-7): 

• Включение и выключение приемника, перевод его в режим низкого 
энергопотребления (Sleep mode). 

• Включение или выключение записи данных (кнопка FUNCTION). 
• Изменение режима отображения. 
• Отображение светодиодом STAT числа отслеживаемых спутников 

GPS (зеленый цвет) и ГЛОНАСС (оранжевый). 
• Отображение состояния записи данных (светодиод REC). 
• Индикация цикла записи данных (светодиод REC). 
• Индикация состава записываемых данных (светодиод REC), 

статический или динамический при выполнении кинематической 
съемки c камеральной обработкой (производится кнопкой FUNCTION). 

• Индикация состояния батарей (полный, средний и низкий заряд) 
(светодиоды Батарея). 

• Индикация состояния питания приемника (светодиоды Батарея). 
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• Индикация состояния модема и приема им данных (светодиод RX TX). 

• Индикация состояния канала Bluetooth (светодиод BT). 
Для настройки параметров MINTER используйте программу PC-CDU. 
Полное описание всех возможностей PC-CDU приводится в “Руководстве 
пользователя PC-CDU”. 
1. Подключите приемник к компьютеру. Эта процедура описана в разделе 

“Подключение приемника к компьютеру“ на стр. 2-19. 
2. В основном окне программы PC-CDU выберите пункт меню File > 

Connect (Файл > Соединить). 
3. В диалоговом окне Connection Parameters (Параметры 

интерфейсов) выставьте флажок RTS/CTS handshaking (квитирование 
сигналами RTS/CTS) (см. рис. 3-17). 
Описание остальных параметров в этом окне приводится в разделе 
“Подключение приемника к компьютеру“ на стр. 2-19. 

4. Щелкните на кнопке Connect (Соединить). 

 
Рисунок 3-17. Диалоговое окно Connection Parameters (Параметры интерфейсов) 

5. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник), затем вкладку MINTER, установите перечисленные ниже 
значения параметров настроек и щелкните на кнопке Apply (см. рис. 
3-18). Описание этих параметров приводится на указанных страницах: 
• Recording interval (Интервал записи) – стр. 3-22. 
• Elevation mask for log file (Минимальный угол места для записи 

данных) -стр. 3-22. 
• File name prefix (Префикс имени файла) – стр. 3-22. 
• Always append to the file (Всегда добавлять к файлу) – стр. 3-23. 
• Files creation mode (Режим создания файлов) – стр. 3-23. 
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• Automatic File Rotation Mode (AFRM) (Режим автоматического 
создания файлов) – стр. 3-23. 

• FN key mode (Функция кнопки FN) -  на стр. 3-24. 
• Initial data collection dynamic mode (Исходная динамическая модель 

при сборе данных) - на стр. 3-25. 
• Data recording auto-start (Восстановление записи данных) – на стр. 

3-25. 

 
Рисунок 3-18. Вкладка MINTER диалогового окна Connection Parameters (Параметры 

интерфейсов) 

Параметр Recording interval (Интервал записи). 
Устанавливает интервал записи блоков измерений в файл измерений. 
Файл измерений создается после нажатия кнопки FUNCTION 
(продолжительность нажатия от 1 до 5 секунд). Эта настройка 
используется как для сохранения единственного файла, так и в режиме 
AFRM (Режим автоматического создания файлов). Диапазон 
допустимых значений – от 1 до 86400 сек. Начальное значение этого 
параметра - 1 секунда. 

Параметр Elevation mask for log file (Минимальный угол места для 
записи данных). 

Устанавливает минимальный угол возвышения для спутников, данные 
измерений для которых записываются в файл, создаваемый после 
нажатия кнопки FUNCTION. Начальное значение - пять градусов. 

Параметр File name prefix (Префикс имени файла). 
Устанавливает начало названия файлов измерений, создаваемых 
приемником после нажатия кнопки FUNCTION. Длина префикса может 
достигать 20 символов. Начальная установка для префикса - “log” 
(“архив”). 
Название файла измерений образуется следующим образом: 
<префикс><месяц><день><очередная буква алфавита> 
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Название файлов формируется из времени создания (месяц и день) 
файла и дополнительных буквенных суффиксов, которые позволяют 
различить файлы, созданные в один день. 

Параметр Always append to the file (Всегда добавлять к файлу). 
Если Вы хотите, чтобы измерения добавлялись в один файл (новые 
файлы создаваться не будут), задайте название такого файла в этом 
параметре. Допустимая длина названия - до 20 символов. 

Параметр Files creation mode (Режим создания файлов). 
Этот параметр задает один из двух возможных рабочих режимов: 

• Log file (файл измерений) - если выбран этот режим, то нажатие на 
кнопку FUNCTION закрывает открытый в настоящий момент файл 
измерений. Если файл измерений не был открыт, то нажатие кнопки 
FUNCTION открывает новый файл измерений. 

• AFRM - если выбран этот режим, то нажатие на кнопку FUNCTION 
включает его. Если режим AFRM уже действует, нажатие кнопки 
FUNCTION отключает его. 

Параметры Automatic File Rotation Mode (AFRM) (Режим 
автоматического создания файлов).  

В приемниках TPS предусмотрен режим автоматического создания 
файлов. В этом режиме по определенному пользователем расписанию 
приемник закрывает текущий файл измерений и открывает новый. 
Параметры Period(Период) и Phase(Фаза) определяют расписание. 
Переключение осуществляется в тот момент, когда остаток от деления 
текущего времени приемника на Period равен Phase. Переключение 
текущего файла измерений производится таким образом, что момент 
относимости первого блока измерений в файле соответствует моменту 
времени, задаваемому в расписании. 
После того, как очередной файл измерений будет открыт, приемник 
сохраняет в этом файле набор типов записей с определенным 
периодом. Набор и период задаются пользователем. 

• Period (Период) - в этом поле указывается продолжительность записи 
каждого из файлов в режиме AFRM. 
Допустимые значения периода – от 60 до 86400 секунд; начальная 
установка – 3600 сек. 

• Phase (Фаза) - устанавливает “фазу” (временной сдвиг внутри периода) 
для создания файла в режиме AFRM. 
Допустимые значения фазы – от 0 до 86400 сек; начальная установка – 
0 сек. 

• Files(total) (Файлов, всего) - параметр, устанавливающий предельное 
количество файлов измерений, создаваемых в режиме AFRM (при 
достижении этого предела режим AFRM отключится). 
Обратите внимание на то, что первый файл измерений создается сразу 
после включения режима AFRM. Этот файл не рассматривается как 
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очередной файл и не увеличивает счетчик, предельное значение 
которого определяется этим параметром. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0. Значение параметра, равное 0, 
устанавливает отмену ограничения на количество записываемых в 
режиме AFRM файлов.  

Максимальное количество файлов во встроенной 
памяти приемника – 512. 

• Files(remain) (Файлов, осталось) – поле отображает количество 
файлов, которое еще можно создать в режиме ARFM. 
Допустимые значения находятся в диапазоне от 0 до (231 –1); 
начальная установка – 0. 

• Automatically remove old files (автоматическое удаление устаревших 
файлов) - этот параметр анализируется, если при записи данных 
свободное пространство во встроенной памяти закончилось. Если 
флажок установлен, то в такой ситуации приемник сотрет наиболее 
ранний файл. Затирание устаревших файлов работает только в режиме 
ARFM. 
Начальная установка – не использовать. 

Параметр FN key mode (Функция кнопки FN). 
Этот параметр определяет поведение приемника при нажатии кнопки 
FUNCTION. 
• LED blink mode switch (Переключатель режима светодиода) –

нажатие клавиши FN осуществляет выбор между режимами 
нормального или расширенного отображения и начинает или 
останавливает запись данных статической съемки. 
− кнопка FUNCTION, нажатая менее чем 1 секунду: выбор между 

режимами нормального или расширенного отображения. 
− кнопка FUNCTION, нажатая от 1 до 5 секунд: запускает или 

останавливает запись данных (режим постобработки 
статической съемки). 

• Occupation mode switch (Переключатель режима съемки) - 
нажатие кнопки FUNCTION (продолжительностью менее 1 
секунды) инициирует добавление в файл измерений сообщения о 
том, что тип съемки был изменен со статического на 
кинематический или наоборот. Если светодиод REC вспыхивает 
зеленым цветом, то текущий режим – кинематическая съемка, если 
оранжевым – статическая съемка. Более подробная информация 
представлена в таблице 1-2 на стр. 1-14, а также в Руководстве 
пользователя PC-CDU. 

Параметр Initial data collection dynamic mode (Исходная динамическая 
модель при сборе данных). 
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В этом поле осуществляется выбор сообщения с признаком типа 
съемки, которое записывается в начало файла измерений. При выборе 
кнопки Static (Статическая) происходит запись сообщения STOP, при 
выборе кнопки Kinematic (Кинематическая) – сообщения GO,Trajectory. 

Параметр Data recording auto-start (Восстановление записи данных). 
В этом поле осуществляется выбор того, каким способом продолжается 
запись файла измерений при восстановлении после сбоя напряжения 
питания. 
В таблице 3-7 приводятся возможные сценарии и результаты при 
восстановлении после сбоя питания приемника. Под термином 
Заданный файл следует понимать название файла, определенное в 
параметре Always append to the file (Всегда добавлять в файл). 
Автоматический файл – файл, название которого создано в режиме 
AFRM. 

Таблица 3-5. Алгоритм, устанавливаемый параметром Data recording autostart 

Результат при выбранном значении параметра Перед сбоем 
питания Off (Выкл.) On (Вкл.) Always (Всегда) 

Измерения 
сохранялись в 
заданном 
файле. 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

После 
восстановления 
питания приемник 
возобновит запись 
данных в тот же 
файл. 

Данные в 
приемнике 
сохранялись в 
автоматическ
ом файле 

После 
восстановления 
питания запись 
данных не 
возобновится. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 

После 
восстановления 
питания откроется 
новый файл, и 
данные будут 
записываться в 
него. 

Название 
файла задано, 
но приемник 
еще не начал 
запись данных 

После 
восстановления 
питания запись 
данных не 
начнется. 

Заданный файл не 
откроется. После 
восстановления 
питания запись 
данных не 
начнется 

Откроется 
заданный файл и 
после 
восстановления 
питания начнется 
запись данных  

Файл не 
установлен; 
запись данных 
приемником 
выключена 

После 
восстановления 
питания запись 
данных не 
начнется 

После 
восстановления 
питания запись 
данных не 
начнется 

Откроется 
автоматический 
файл и после 
восстановления 
питания начнется 
запись данных 
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Помимо этого, если выбрано поле Always, приемник автоматически начнет 
запись данных (во вновь созданный или уже существующий файл) в 
следующих трех случаях: 

• После включения приемника с помощью кнопки POWER (питание) 
• После перезапуска приемника с помощью PC-CDU. 
• После выведения приемника из режима пониженного 

энергопотребления. 

 
Рисунок 3-19. Вкладка MINTER 
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Глава 4  
Установка и съемка 
После того, как приемник настроен, для проведения съемки его следует 
установить над пунктом, измерить высоту антенны над центром. MINTER 
обеспечивает простое начало записи данных, изменение режима работы 
приемника и контроль за процессом проведения съемки, в т.ч. просмотр 
данных о наблюдаемом созвездии.  

Установка приемника 
Обычно спутниковую съемку производят, установив базовую станцию на 
пункте с известными координатами, а подвижный приемник используют для 
определения пикетов. После установки приемника над пунктом следует 
измерить высоту антенны над центром. 
До начала сбора данных следует убедиться в том, что и базовый, и  
подвижный приемник обладают текущими альманахом и эфемеридными 
данными (подробнее см. раздел “Сбор альманахов и эфемерид” на стр. 2-
26). 

Шаг 1: Установка приемника 
Базовую станцию следует установить, запустить на ней процесс накопления 
данных и передачи дифференциальных поправок до включения подвижного 
приемника. Устанавливаются приемники для RTK или камеральной 
обработки измерений одинаково. 
□ Установите базовый приемник и прочие компоненты базовой станции. 

Подробнее см. раздел "Установка базового приемника" на стр. 4-2. 
□ Установите подвижный приемник. Подробнее см. раздел "Установка 

подвижного приемника" на стр. 4-3. 
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Установка базового приемника (см. рис. 4-1): 

1. Установите  штатив  над  центром  с известными  координатами . 

2. Закрепите  стандартный  трегер  на штативе . Закрепите  адаптер  трегера  
(стандартный , либо  адаптер  точной установки ) на трегере  и затяните  
винты . 

3. В  адаптер  точной установки  вставьте  втулку .  

4. Закрепите  приемник на адаптере  трегера . К антенному  разъему  
радиомодема , расположенному  в верхней  части  приемника, 
подсоеди ните  антенну . 

5. Отнивелируйте  прибор и затяните  винты . 

6. При необходимости  подсоедините  дополнительные  принадлежности  
(например , дополнительный  источник питания ). 

 
Рисунок 4-1. Установите штатив и приемник над исходным пунктом 
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Установка подвижного приемника (см. рис. 4-2): 

1. При необходимости  закрепите  адаптер  быстрой  установки  на двуногом  
штативе  или вехе . 

При сборе  данных  для  последующей  статической  
обработки  используйте  двуногий  штатив , 
обеспечивающий  неподвижность  антенны  
относительно  земли  в процессе  съемки . 

2. Закрепите  приемник GR- 5 на адап тере  быстрой  установки . Убедитесь  в 
том, что защелки  замкнулись . 

3. К антенному  разъему  радиомодема , расположенному  в верхней  части  
приемника , подсоедините  антенну . 

 
Рисунок 4-2. Установите штатив и приемник над исходным пунктом 

5
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Шаг 2: Измерение высоты антенны 
Определение превышения антенны над центром пункта чрезвычайно важно 
при использовании спутниковых методов съемки. Даже если определению 
подлежат только плановые координаты, обработка данных спутниковой 
съемки всегда производится с определением полного (трехмерного) 
местоположения фазового центра приемной антенны.  
Поскольку при обработке спутниковых измерений определяются 
координаты фазового центра антенны, для их редукции на центр пункта, 
производимой при обработке измерений, следует указать следующее: 

• Измеренную высоту антенны над центром пункта. 

• Метод измерения высоты антенны. 

• Модель используемой антенны. 
Измерять высоту антенны можно двумя способами: 

• Вертикальный – измеряется длина отрезка от центра (марки) пункта 
до базовой точки антенны (antenna reference point, ARP) 
расположенной на нижнем основании втулки под становой винт. 

• Наклонный - измеряется длина отрезка от центра (марки) пункта до 
одной из точек относимости наклонной высоты (slant height measure 
mark, SHMM), нанесенных на лицевой и задней панелях приемника. 

Точка, координаты которой определяются в процессе съемки с помощью 
GPS/ГЛОНАСС, называется фазовым центром антенны. Можно провести 
аналогию с триппель-призмой, при измерении расстояний до которой 
измерение производится до точки, расположенной внутри призмы, и 
поэтому следует учитывать в обработке измерений постоянную призмы. В 
случае GPS/ГЛОНАСС антенны порядок учета смещения фазового центра 
зависит от использованного способа измерения высоты антенны.  

• Для вертикального измерения (измерение до ARP) смещение просто 
добавляется к измеренной высоте и получается «истинное» 
превышение.  

• Для наклонной высоты (измерение до SHMM), прежде всего 
производится редукция этого измерения на вертикального (с учетом 
известного радиуса антенны), после чего порядок действий 
аналогичен приведенному выше. 

Смещения вычисляются разными способами из-за несовпадения точек ARP 
и SHMM. 
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1. Измерьте высоту антенны над центром (маркой) пункта методом 
наклонного или вертикального измерений (см. рис. 4-3). 

2. В полевой журнал занесите название пункта, высоту антенны над 
центром и способ ее измерения, укажите время начала работы 

 
Рисунок 4-3. Измерение смещения антенны 

• Вертикальное расстояние от SHMM до ARP равно 168 мм. 
• Радиус от SHMM до ARP 78.3 мм до стороны; 95.8 мм до угла. 

В таблице 4-1 приводятся величины смещений для приемника GR-5. 
Таблица 3-5. Величины смещений для приемника GR-5 

 ARP до фазового центр L1 ARP до фазового центр L2 

Вверх 228.8 мм 216.3 мм 
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Шаг 3. Сбор данных 
Помимо этого раздела данному вопросу посвящен также весь остаток этой 
главы. 
1. Включите приемник. Светодиод STAT должен кратковременно  

вспыхнуть красным цветом. 
2. Как только приемник установит слежение за сигналом одного или 

нескольких спутников, светодиод STAT будет подсвечиваться зеленым 
цветом для спутников GPS и оранжевым – ГЛОНАСС (количество 
вспышек соответствует количеству отслеживаемых спутников каждой 
системы). Короткая красная вспышка обозначает отсутствие решения 
навигационной задачи. Местоопределение может обеспечиваться при 
слежении за четырьмя и более спутниками. 

3. Окончание коротких красных вспышек свидетельствует о том, что, 
приемник определил местоположение и можно начинать съемку. Перед 
началом сбора данных следует дождаться появления зеленых и 
оранжевых вспышек. Это гарантирует то, что приемник определил 
правильные дату и время, а также отслеживает достаточное количество 
спутников, что позволит собрать измерительные данные надлежащего 
качества.  
Процесс захвата спутниковых сигналов обычно занимает менее одной 
минуты. На новом месте, под густой кроной деревьев или после 
перезапуска приемника это может занять несколько минут 

4. Для начала сбора данных нажмите и удерживайте в нажатом состоянии 
кнопку FUNCTION более одной секунды, но менее пяти секунд. 

5. Отпустите кнопку FUNCTION, когда светодиод REC (recording – запись) 
станет светиться зеленым цветом. Это указывает на то, что файл 
открылся, и запись данных началась. Светодиод вспыхивает каждый 
раз, когда происходит сохранение данных  во внутреннюю память. 

  

Для настройки процесса сохранения данных 
используйте программу PC-CDU, см. раздел 
“Настройка MINTER”на стр. 3-20 или обратитесь к 
Руководству пользователя PC-CDU. 

6. По окончании сеанса наблюдений нажмите и удерживайте кнопку 
FUNCTION до тех пор, пока светодиод REC не погаснет. 

7. Для выключения приемника нажмите и удерживайте в нажатом 
состоянии кнопку питания до тех пор, пока все светодиоды не погаснут, 
после чего отпустите ее. 
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Использование MINTER 
Пользовательский интерфейс MINTER для отображения состояния 
приемника и контроля ввода/вывода данных (см. рис. 4-4). 

 
Рисунок 4-4. MINTER приемника GR-5 

С помощью MINTER можно осуществить разнообразные операции, в том 
числе: 

• Включение и выключение приемника. 
• Включение или выключение записи данных (кнопка FUNCTION). 
• Изменение режима отображения. 
• Отображение светодиодом STAT числа отслеживаемых спутников 

GPS (зеленый цвет) и ГЛОНАСС (оранжевый). 
• Отображение состояния записи данных (светодиод REC). 
• Индикация цикла записи данных (светодиод REC). 
• Индикация состава записываемых данных (светодиод REC), 

статический или динамический, при выполнении кинематической 
съемки c камеральной обработкой. 

• Индикация состояния батарей (полный, средний и низкий заряд) 
(светодиоды Батарея). 

• Индикация состояния питания приемника (светодиоды Батарея). 
• Индикация состояния модема и приема им данных (светодиод RX TX). 

• Индикация состояния канала Bluetooth (светодиод BT). 



Установка и съемка 

 GR-5. Руководство пользователя 4-8 

Полное описание MINTER приводится в разделе “MINTER” на стр. 1-11. 
Включение и выключение приемника производится нажатием на кнопку 
Включение (Питание) (см. рис. 4-5). 

• Для включения приемника нажмите и удерживайте в нажатом 
состоянии кнопку Питание до тех пор, пока все светодиоды не 
засветятся. 

• Для выключения приемника нажмите и удерживайте в нажатом 
состоянии кнопку Питание до тех пор, пока все светодиоды не 
погаснут. 

 
Рисунок 4-5. Использование кнопки Питание 

Начало и окончание записи данных производится нажатием на кнопку 
FUNCTION  в течение 1-5 секунд (см. рис. 4-6). 

• Во время записи данных светодиод REC светится зеленым цветом. 
Интервал (период) записи устанавливается с помощью программы 
PC-CDU, подробнее см. раздел “Параметр Recording interval 
(Интервал записи)” на стр. 3-22. 

• Всякий раз, когда производится запись данных на SD/MMC карту 
памяти, светодиод REC вспыхивает зеленым цветом. 

• Если светодиод REC светится красным цветом, это означает 
переполнение памяти приемника, или возникновение аппаратного 
отказа, или отсутствие карты памяти SD/MMC или то, что в приемнике 
установлен неправильный OAF (подробнее см. раздел “Файл 
авторизации опций (OAF)”, стр.1-23). 

С помощью программы PC-CDU устанавливается режим работы кнопки 
FUNCTION - LED blink mode switch (Переключатель режима светодиода) 
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для статической съемки, или Occupation mode switch (Переключатель 
режима съемки) для кинематической съемки. Подробнее см. раздел 
“Параметр FN key mode (Функция кнопки FN)” на стр. 3-24. 
При каждом начале или окончании записи открывается новый файл, или 
данные записываются в специально указанный файл. Подробно настройка 
поведения приемника описывается в разделах “Параметр Always append to 
the file (Всегда добавлять к файлу)” на стр. 3-23 и “Параметр Files creation 
mode (Режим создания файлов)” на стр. 3-23. 

 
Рисунок 4-6. Использование кнопки FUNCTION 

Переключение между режимами обработки производится нажатием 
кнопки FUNCTION на время менее 1 секунды (если с помощью PC-CDU был 
разрешен режим Occupation mode switch (Переключатель режима съемки)). 
Изменение информационного режима приемника производится 
нажатием кнопки FUNCTION на время менее 1 секунды (если с помощью 
PC-CDU был разрешен режим LED blink mode switch (Переключатель 
режима светодиода)). 
Изменение скорости обмена по последовательному порту приемника 
производится нажатием кнопки FUNCTION на время от 5 до 8 секунд. Эта 
функция полезна, если подсоединенное к приемнику устройство не 
поддерживает установленную для порта скорость обмена. 
После удержания в нажатом состоянии кнопки FUNCTION в течение 5 
секунд индикатор REC подсвечивается красным цветом. Отпустите клавишу 
в течение следующих 3 секунд. 
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Статическая съемка 
Статическая съемка является классическим методом съемки, хорошо 
подходящим для всех размеров базисов (коротких, средних и длинных). По 
крайней мере, две антенны приемников, центрированные над пунктами, 
одновременно собирают измерительные данные на концах базиса в 
течение некоторого периода времени. Эти два приемника должны 
одновременно отслеживать четыре (или более) спутника, записывать 
данные с одинаковым периодом и иметь одинаковые значения угла 
предельного возвышения. Продолжительность сеанса измерений может 
варьироваться от нескольких минут до нескольких часов. Оптимальная 
продолжительность сеанса измерений определяется опытным путем и 
зависит от следующих факторов: 

• Длины измеряемой базовой линии. 

• Количества спутников в поле зрения. 

• Геометрического фактора (Dilution of Precision, DOP). 

• Расположения антенны. 

• Уровня активности ионосферы. 

• Типа используемых приемников. 

• Требований по точности. 

• Необходимости разрешения неоднозначности фазы несущей. 
В общем случае, одночастотные приемники используются для базовых 
линий, длина которых не превышает 15 км.  Для базовых линий длиной 
свыше 15 км следует применять двухчастотные приемники. 
Двухчастотные приемники имеют два больших преимущества. Во-первых, 
измерения по двум частотам позволяют почти полностью устранить 
ионосферные погрешности в измерениях фазы кода и несущей, 
обеспечивая большую точность, чем одночастотные приемники при 
определении длинных базисов и во время повышенной активности 
ионосферы (ионосферных штормов). Во-вторых, двухчастотным 
приемникам требуется значительно более короткие сеансы измерений для 
получения определений заданной точности. 
После окончания съемки данные, собранные приемниками, могут быть 
загружены в компьютер и обработаны с помощью программного 
обеспечения камеральной обработки (например, Topcon Tools). 
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Кинематическая съемка 
При кинематической съемке стационарный приемник (базовая станция) 
устанавливается на точку c известными координатами (например, 
геодезический пункт). Приемник непрерывно отслеживает спутники и 
сохраняет данные измерений в своем запоминающем устройстве. 
Подвижный приемник устанавливается в неизвестной точке и собирает 
данные в статическом режиме в течение от 2 до 10 минут. После окончания 
съемки на точке подвижную станцию следует перевести в кинематический 
режим и переместить в новую точку съемки. В этой точке и во всех 
последующих приемник переводится в режим статической съемки для 
сбора данных. Таким образом, при движении подвижная станция работает в 
кинематическом режиме, а во время сбора данных - в статическом режиме. 
1. Установите подвижную станцию в определяемой точке и нажмите кнопку 

Питание. Собирайте данные в течение 2-10 минут. Светодиод REC 
будет светиться оранжевым цветом. 

2. Проверьте индикацию светодиода STAT для отслеживаемых спутников. 
3. После завершения сеанса наблюдений нажмите кнопку FUNCTION 

более чем на секунду для перевода подвижной станции в 
кинематический режим. 

  

Если светодиод REC мерцает зеленым цветом – 
текущий режим сбора данных статический, 
оранжевый - динамический. 

4. Переместите подвижную станцию на следующую точку съемки и 
нажмите кнопку FUNCTION менее чем на секунду для того, чтобы 
перевести ее в статический режим. Собирайте данные в течение 2-10 
минут.  

5. Повторяйте шаги 3 и 4 до тех пор, пока не будет проведена съемка во 
всех точках. Время работы на точке зависит от факторов, указанных для 
статического метода съемки. 

6. Для завершения работы нажмите и удерживайте кнопку FUNCTION от 1 
до 5 секунд для прекращения записи данных. Если это необходимо, 
выключите подвижную станцию. 

Этот метод GPS-съемки позволяет оператору сократить время пребывания 
на точке, предоставляя полевой бригаде возможность провести съемку 
значительно большего количества пунктов по сравнению со статическим 
методом. 
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Кинематическая съемка в 
реальном времени 
При съемке методом RTK, как и при описанной выше кинематической 
съемке, один из приемников является базовой станцией и производит 
измерения сигналов, принимаемых антенной, закрепленной на штативе 
(или другим способом) над центром с известными координатами. Второй 
приемник используется в качестве подвижного и производит измерения 
положения фазового центра подключенной к нему антенны, размещаемой 
над определяемыми пунктами. 
В отличие от кинематической съемки, результаты которой вычисляются в 
процессе камеральной обработки измерений, в методе RTK используется 
телеметрический канал связи между базовым и подвижным приемниками. 
Базовая станция, используя радиомодемный канал связи, передает 
производимые ей измерения и собственные координаты подвижному 
приемнику. Последний, используя собственные измерения и принятые по 
каналу связи данные, немедленно вычисляет элементы определяемого 
базиса и выдает их потребителю. Настройка RTK режима рассматривается 
в разделах “Настройка радиомодема” на стр. 3-3 и “Настройка приемника” 
на стр. 3-10. 
При использовании программы PC-CDU для контроля подвижного 
приемника RTK проконтролируйте показания в поле LQ (Link Quality – 
качество канала связи) в главном окне программы (см. рис 4-7 на стр. 4-13), 
чтобы убедиться в том, что приемник принимает дифференциальные 
поправки. Обычно приемник начнет выдавать координаты фазового центра 
антенны вместе с типом решения в пределах 10-30 секунд. Однако при 
использовании радиосредств с расширением спектра только на 
установление связи может понадобиться до 60 секунд 
Определяемые приемником геодезические координаты фазового центра 
антенны, отображаемые на вкладке Geo, всегда вычисляются в системе 
координат WGS-84 и могут иметь 4 типа решения: 

• Standalone (автономное) – приемник вычисляет трехмерное 
положение в автономном режиме, без использования 
дифференциальных поправок. 

• Code Differential (Дифференциальное по измерениям фазы кода) – 
подвижный приемник вычисляет текущие координаты в 
дифференциальном режиме с использованием измерений кодовой 
задержки. 

• RTK float (RTK без целочисленного разрешения неоднозначности)-  
подвижный приемник вычисляет текущие относительные координаты 
в дифференциальном режиме с использованием кодовой задержки и 
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фазы несущей, однако, разрешение неоднозначности фазового 
измерения до целого значения не происходит, а неоднозначность 
разрешается как нецелое число. 

• RTK fixed (RTK с целочисленным разрешением неоднозначности) – 
подвижный приемник вычисляет текущие относительные координаты 
в дифференциальном режиме с фиксированием неоднозначности 
измерения разности фаз несущей до целых величин. 

Поле LQ отображает состояние получаемых дифференциальных 
сообщений и содержит следующие данные: 

• Качество линии связи в процентах. 
• Время (в секундах), прошедшее со времени получения последнего 

сообщения. 
• Общее количество безошибочно полученных сообщений 

(определяется типом получаемых сообщений). 
• Общее количество сообщений, полученных с ошибками 

(определяется типом получаемых сообщений). 
Если приемник не получает дифференциальные поправки, или ни один из 
его портов не был настроен для получения дифференциальных поправок, 
поле LQ будет либо пустым, либо отобразит следующее: 100% 
(999,0000,0000). 

 
Рисунок 4-7. Основное окно программы PC-CDU 
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Для заметок: 
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Глава 5  
Обслуживание 
приемника и 
операции с файлами 
Перед началом камеральной обработки данные, собранные во время  
сеансов полевых измерений, следует загрузить в компьютер. Загрузка и 
удаление файлов также освобождает место для записи данных 
следующей съемки. Процедура очистки энергонезависимой памяти также 
может также понадобиться для устранения затруднений в слежении и 
устранении отказов канала связи. 
При повышении требований к прибору может потребоваться обновление 
OAF. Разнообразные модули, входящие в состав приемника (платы 
спутникового приемника, питания, радиомодема и Bluetooth) оснащены 
процессорами и, соответственно, исполняют управляющие программы, 
которым может потребоваться обновление. По мере выпуска обновлений 
фирмой TPS загрузка их в приемник обеспечивает максимально полное 
использование его возможностей. 

Копирование файлов в 
компьютер 
По окончании съемки следует переписать собранные файлы с данными в 
компьютер для хранения, обработки и создания резервной копии. 
Обратите внимание на то, что память приемника может содержать 
конечное число файлов, и объем данных также ограничен, т.е. перенос 
файлов в компьютер предотвратит потерю данных измерений. Программы 
PC-CDU и Topcon Link обеспечивают возможность загрузки файлов в 
персональный компьютер и их последующего удаления из памяти 
приемника. Обе эти программы предоставляются бесплатно и будут 
предоставлены Вам поставщиком оборудования по Вашему запросу. 



Обслуживание приемника и операции с файлами 

 GR-5. Руководство пользователя 5-2 

 

  

Для копирования файлов с карты памяти SD 
используйте программу Topcon Tools. Подробные 
инструкции см. в Руководстве пользователя Topcon 
Tools. 

Копирование файлов с помощью 
Topcon Link 
Программа Topcon Link предусматривает два варианта копирования 
файлов из памяти приемника: с использованием Проводника ОС 
Windows(R) или из собственно программы Topcon Link. 
Перед началом процесса переноса файлов Вам следует установить 
соединение между приемником и компьютером (подробнее см. раздел 
“Подключение приемника к компьютеру” на стр. 2-19). 

…через Проводник Windows 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на стр. 2-19). 
2. Запустите Проводник и щелкните на папке Topcon Receiver. В правой 

панели будут отображаться ведение автоматического поиска 
приемников Topcon, подсоединенных ко всем имеющимся на 
компьютере портам COM и USB. 

3. После окончания процесса поиска будут отображены пиктограммы, 
обозначающие все приемники, подсоединенные к портам компьютера. 

 
Рисунок 5-1. Поиск и обнаружение приемников Topcon в Проводнике Windows 
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4. Если нужный Вам приемник уже обнаружен, прервать процесс поиска 
можно щелчком на кнопке Stop (Остановить). При этом будут 
отображены пиктограммы, обозначающие только те приемники, 
которые были обнаружены к этому моменту. 

 
Рисунок 5-2. Прекращение поиска приемников 

5. Обновление данных о приемниках, подсоединенных к портам 
компьютера, производится щелчком по пиктограмме Search for 
connected receivers (Поиск подсоединенных приемников). 

6. Для просмотра данных о приемнике (см. рис. 5-3) щелкните по правой 
кнопкой мыши на иконке нужного приемника и в появившемся меню 
выберите пункт Properties (Свойства). 

7. Для просмотра списка файлов нужного приемника щелкните на 
пиктограмме этого прибора. 

 
Рисунок 5-3. Свойства приемника 

8. Перенос файлов в файловую систему компьютера производится 
методом перетаскивания в нужную папку, см. рис. 5-4. 

 
Рисунок 5-4. Начало импорта файлов и течение этого процесса 
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…через Topcon Link 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на стр. 2-19). 
2. Запустите Topcon Link щелчком на кнопке Import from Device (Импорт 

из устройства) панели инструментов. 
3. В левой панели диалогового окна Import from Device (Импорт из 

устройства) выберите пиктограмму Topcon Receivers двойным 
щелчком (см. рис. 5-5). 

 
Рисунок 5-5. Диалоговое окно Import from Device (Импорт из устройства) 

4. Программа осуществит автоматический поиск приемников Topcon, 
подсоединенных ко всем имеющимся на компьютере портам COM и 
USB. После окончания процесса поиска будут отображены иконки, 
обозначающие все приемники, подсоединенные к портам компьютера. 

 
Рисунок 5-6. Поисков приемников Topcon 



Загрузка файлов в компьютер 

P/N 7010-0736 5-5 

5. Для просмотра данных о приемнике щелкните по правой кнопкой мыши 
на иконке нужного приемника и в выпадающем меню выберите пункт 
Properties (Свойства) (см. рис. 5-7). 

 
Рисунок 5-7. Свойства приемников 

6. В правой панели диалогового окна Import from Device (Импорт из 
устройства) выберите или, при необходимости, создайте папку, 
предназначенную для размещения файлов (см. рис. 5-8). 

7. Для просмотра списка файлов нужного приемника выберите этот 
прибор двойным щелчком по его пиктограмме или выбором пункта 
меню Select (Выбор) в выпадающем меню. Для импорта файлов из 
приемника в выбранную папку компьютера выделите их и щелкните на 
кнопку с двойной стрелкой (см. рис. 5-8).  

8. Происходит отображение процесса импорта. 

 
Рисунок 5-8. Выбор файла и отображение процесса импорта 
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Копирование файлов с помощью 
PC-CDU 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на стр. 2-19). 
2. Запустите программу PC-CDU. В диалоговом окне Connection 

Parameters (Параметры интерфейсов) выставьте флажок RTS/CTS 
handshaking (квитирование сигналами RTS/CTS) (см. рис. 5-9). 

 
Рисунок 5-9. Диалоговое окно Connection Parameters – флажок RTS/CTS 

handshaking 
3. Выберите пункт меню File > File Manager (Файл > Управление 

файлами) и в появившемся диалоговом окне File Manager 
(Управление файлами) выберите вкладку Download path (Каталог 
для загрузки), см. рис. 5-10. 

 
Рисунок 5-10. Выбор файлов для загрузки 

4. Выберите или создайте (с помощью кнопки Create (Создать)) папку, 
предназначенную для хранения файлов. 
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5. Выберите вкладку Download files (Файлы для загрузки) и в ней 
отметьте файлы, подлежащие копированию (см. рис. 5-11 на стр. 5-7). 
Выбор нескольких подряд расположенных файлов производится с 
удержанием клавиши Shift, а группы из отдельных файлов - клавиши 
Ctrl. 

 
Рисунок 5-11. Загрузка файлов 

6. Щелкните на кнопке Download (Загрузка). Во время загрузки возле 
каждого файла отображаются индикаторы состояния загрузки (см. рис 
5-12). 

• Голубой – файл в очереди загрузки. 
• Красный - файл загружается. 
• Зеленый – файл успешно загружен. 

 
Рисунок 5-12. Индикаторы состояния загрузки файлов 

7. По окончании процедуры копирования файлов щелкните на кнопке Exit 
(Выход) диалогового окна File Manager. 
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8. Продолжите работу с программой, или завершите ее выполнение, 
последовательно выбрав пункты меню File > Disconnect и File > Exit. 

Удаление файлов с SD карты 
приемника 
Для удаления файлов из файловой системы приемника проделайте 
перечисленные ниже операции: 
1. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на стр. 2-19). 
2. Запустите программу PC-CDU. В диалоговом окне Connection 

Parameters (Параметры интерфейсов) выставьте флажок RTS/CTS 
handshaking (квитирование сигналами RTS/CTS) (см. рис. 5-13). 

 
Рисунок 5-13. Диалоговое окно Connection Parameters – флажок RTS/CTS 

handshaking 
3. Выберите пункт меню File > File Manager (Файл > Управление 

файлами) и в появившемся диалоговом окне File Manager 
(Управление файлами) выберите вкладку Download path (Каталог 
для загрузки), см. рис. 5-14 на стр. 5-9. 
Выбор нескольких подряд расположенных файлов производится с 
удержанием клавиши Shift клавиатуры, а группы из отдельных файлов 
- клавиши Ctrl. 

4. Щелкните на кнопке Delete (Удаление), см. рис. 5-14 на стр. 5-9. 
5. Щелкните на кнопке Yes (Да) в диалоговом окне подтверждения 

удаления файлов. Происходит удаление выбранных файлов. 
6. Щелкните на кнопке Exit (Выход) диалогового окна File Manager. 
7. Продолжите работу с программой, или завершите ее выполнение, 

последовательно выбрав пункты меню File > Disconnect и File > Exit. 
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Рисунок 5-14. Удаление файлов 

Организация памяти 
приемника 
При использовании приемника в статических и динамических приложениях 
Вам может понадобиться оценить размер файлов с данными измерений, 
которые записываются в приемник. Конкретный размер файла зависит от 
типа записываемых данных. Приближенный расчет размеров таких 
файлов можно произвести по приведенным ниже формулам. Эти 
соотношения основаны на размере набора сообщений, записываемых по 
умолчанию. 

• SS – ориентировочный размер записи одной эпохи данных в файле с 
измерительной информацией (выражается в байтах). 

• N – число спутников, которые отслеживаются в этой эпохе. 
При записи данных только по L1: 

SS = 183+22*N 
При записи данных по L1 и L2: 

SS = 230 + 44*N
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Управление опциями 
приемника 
Файл Авторизации опций позволяет работу отдельных функции 
приемника: 

• Тип сигнала (L1,L1/L2, и т.д.), с которым будет работать приемник. 

• Количество информации, которое приемник сохранит в памяти. 

• Темп передачи или приема данных. 
Полный список доступных деталей и опций вы можете узнать у своего 
дилера Topcon. 

Проверка OAF приемника 
Для выяснения текущего состояния опций приемника используйте PC-
CDU. 
1. Подключите приемник к компьютеру (подробнее см. раздел 

“Подключение приемника к компьютеру” на стр. 2-19). 
2. Выберите пункт меню Tools > Receiver Options (Инструменты > 

Опции приемника). В диалоговом окне Option Manager (Управление 
опциями) (см. рис. 5-15 на стр. 5-11), содержится следующая 
информация: 

• Option Name (Название опции) – Название/описание опции. 

• Current (Текущий) – текущее состояние опции. 

• Purchased (Приобретенный) – приобретена опция или нет. 

• Leased (Арендованный) - арендована опция или нет. 

• Expiration date (Дата окончания действия) – дата, когда опция будет 
отключена, если действие опции имеет временное ограничение. 

Опции могут быть как приобретены, так и арендованы, столбец Current 
(Текущее) отображает текущее состояние опции: 
• 1 или “-----“ -  встроенное программное обеспечение не 

поддерживает опцию. 
• 0 – опция приемника отключена. 
• Положительное целое число – опция включена. 
• уes (да) или  no (нет) - опция включена или выключена 

соответственно. 
3. После завершения работы щелкните на кнопке Exit (Выход) в 

диалоговом окне Option Manager, затем выберите пункт меню File > 
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Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту. 

 
Рисунок 5-15. Окно Option Manager (Управление опциями) 
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Загрузка OAF 
Дистрибьютор Topcon Positioning System обеспечивает пользователей 
файлами OAF (файл авторизации опций). По всем вопросам, касающимся 
OAF, делайте запросы по адресу e-mail service@gsi.ru. Пожалуйста, 
указывайте идентификационный номер (ID) приемника, указанном на 
шильдике, закрепленном в нижней части прибора. 
1. Для загрузки нового OAF выполните шаги один и два раздела 

“Проверка OAF приемника” на стр. 5-10. 
2. Щелкните на кнопке Load (Загрузить), расположенной в нижней части 

диалогового окна Options Manager (Управление опциями), см. рис. 
5-15 на стр. 5-11. 

3. Выберите каталог, где находится новый файл авторизации опций OAF. 
Эти файлы имеют расширения .jpo или .tpo и уникальны для каждого 
приемника (см. рис. 5-16). 

 
Рисунок 5-16. Загрузка OAF 

4. Выберите соответствующий файл и щелкните на кнопке Open 
(Открыть) (см. рис. 5-16). Новая опция приемника загрузится в 
приемник и таблица в диалоговом окне Option Manager  обновится.  

5. После завершения работы щелкните на кнопке Exit (Выход) в 
диалоговом окне Options Manager, затем выберите пункт меню File > 
Disconnect (Файл > Отключение) для предотвращения конфликтов в 
доступе к последовательному порту.  
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Очистка энергонезависимой 
памяти (NVRAM) 
В энергонезависимом оперативном запоминающем устройстве (NVRAM) 
приемника хранятся данные, необходимые для слежения за спутниками 
(эфемериды и координаты приемника). Энергонезависимое ОЗУ хранит 
также текущие установки приемника, такие как сведения об антенне, 
минимальный угол места и интервал записи, а также данные о внутренней 
файловой системе приемника. 
Хотя очистка энергонезависимого ОЗУ не является часто используемой 
(или даже рекомендуемой при нормальных условиях эксплуатации) 
операцией, встречаются ситуации, когда очистка энергонезависимого ОЗУ 
может устранить проблемы слежения за спутниками и обмена по 
интерфейсным портам. Очистку энергонезависимого ОЗУ приемника 
можно сравнить с перезапуском операционной системы персонального 
компьютера.  
После очистки энергонезависимого ОЗУ приемнику требуется около 15 
минут для получения новых эфемерид и альманаха. 
В ходе очистки энергонезависимого ОЗУ приемника не происходит 
удаления каких-либо файлов, уже записанных в память приемника. 
Очистка приводит к переустановке настроек приемника к первоначальным 
заводским значениям. 
Следует отметить, что после очистки энергонезависимого ОЗУ в течение 
нескольких секунд светодиод STAT вспыхивает оранжевым цветом, 
показывая, что приемник сканирует память, проверяя файловую систему. 

Использование MINTER для очистки 
NVRAM 
1. Нажмите и отпустите кнопку питания для того, чтобы выключить 

приемник.  
2. Нажмите и не отпускайте кнопку FUNCTION. 
3. Нажмите и удерживайте кнопку питания примерно 1 секунду. Отпустите 

кнопку питания, кнопку FUNCTION следует удерживать в нажатом 
состоянии. 

4. Подождите, пока светодиоды STAT и REC не станут зелеными. 
5. Подождите, пока светодиоды STAT и REC не начнут вспыхивать 

оранжевым цветом. 
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6. Отпустите кнопку FUNCTION при вспыхивающих оранжевым цветом 
светодиодах STAT и REC. 

Использование PC-CDU для очистки 
NVRAM 
1. Подключите приемник к компьютеру (подробнее см. раздел 

“Подключение приемника к компьютеру” на стр. 2-19). 
2. Выберите пункт меню Tools > Clear NVRAM (Инструменты > 

Очистить энергонезависимое ОЗУ) (см. рис. 5-17 

 
Рисунок 5-17. Очистка NVRAM с помощью PC-CDU 

Светодиод REC будет вспыхивать зеленым и красным цветом; светодиод 
STAT – красным. После окончания очистки приемник автоматически 
разорвет соединение с компьютером. 

Изменение режима работы 
приемника 
Приемник может находиться в трех режимах, два из них – режимы 
отображения, а третий - режим энергосбережения: 

• Normal Mode (Нормальный режим) – стандартный режим съемки. 
• Extended Information Mode (Расширенный режим отображения) – 

используется для проверки работоспособности. 
• Sleep mode (Режим низкого энергопотребления) – используется для 

остановки записи информации, но сохраняет питание приемника для 
быстрого возвращения в рабочий режим. 

Вход в расширенный режим 
отображения 
Расширенный режим отображения используется для тестирования 
приемника. В этом режиме приемник продолжает работать как обычно. 
Светодиод STAT указывает «расширенную» информацию с помощью 
разграничителя.
В качестве разграничителя используется хорошо различимая двойная 
вспышка, который показывает суммарный результат цикла проведенных 
тестов. Цвет светодиода для разграничителя определяется цветом 
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вспышек, характеризующих произведенные тесты, по следующим 
правилам: 

• Оранжевый – по крайней мере, одна из вспышек была оранжевой. 

• Красный – оранжевых вспышек не было, однако была, по крайней 
мере, одна красная вспышка. 

• Зеленый – во всех остальных случаях. 
За разграничителем следуют шесть вспышек светодиодов, 
соответствующие шести тестам приемника, причем каждая из вспышек 
указывает на следующее:

Вспышка 1. Достаточно ли данных для местоопределения.  
Вспышка 2. Приемлемо ли отношение сигнал/шум в каналах приема  

сигналов GPS (см. табл. 4-2) 
Вспышка 3. Достаточно ли отношение сигнал/шум в каналах приема  

сигналов ГЛОНАСС (см. табл. 4-2). 
Вспышка 4. Смещение частоты встроенного задающего генератора 

относительно номинала менее трех миллионных. 
Вспышка 5. Вариация Аллана встроенного задающего генератора 

менее 2,7*10-10.  
Вспышка 6. Время непрерывного слежения составляет более 15 

минут. 
Таблица 4-2. Приемлемые отношения сигнал/шум 

 CA/L1 P/L1 P/L2 

GPS 51 39 39 

ГЛОНАСС 51 49 40 

Цвет вспышек показывает, что данных для теста недостаточно 
(оранжевый), приемник прошел тест (зеленый) или приемник тест не 
прошел (красный). 
1. Для включения режима расширенного отображения нажмите и быстро 

(в пределах одной секунды) отпустите кнопку FUNCTION на передней 
панели приемника. 

2. Следите за разграничителем. Если приемник исправен и антенна 
размещена правильно, то в пределах 15 минут после включения 
питания будут индицироваться исключительно зеленые вспышки. 
Цветовое кодирование результатов тестов и окончательной 
диагностики следующее: 
• зеленый – тест пройден успешно. 
• оранжевый – тест не закончен. 
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• красный – некоторые тесты не прошли 
3. Для переключения в нормальный режим отображения нажмите кнопку 

FUNCTION. 

Режим низкого энергопотребления 
В режиме низкого энергопотребления плата питания и модуль Bluetooth 
продолжают потреблять энергию батарей, постепенно их разряжая. Этот 
режим является штатным состоянием “выключено” этого приемника. 
1. Включите приемник. 
2. Нажмите и удерживайте кнопку питания от 4-х, но не более 8-и секунд. 

Светодиод STAT засветится оранжевым цветом. Приемник перейдет в 
режим низкого энергопотребления. 

3. Прием произвольного символа по последовательному интерфейсу 
выведет приемник из этого режима в нормальный режим работы. 

Удержание кнопки Питание в нажатом состоянии 
более 14-и секунд будет проигнорировано (таким 
образом реализована защита от западания кнопки). 

 

Загрузка нового встроенного 
программного обеспечения 
Приемники базовой и подвижной станции должны управляться 
встроенным программным обеспечением той же самой версии. Получить 
последнюю версию встроенного программного обеспечения можно через 
службу технической поддержки. 

В приемнике GR-5 следует использовать встроенное 
программное обеспечение версии 3.0 или более 
новое. 

 

Не пытайтесь загрузить программное обеспечение 
версии более ранней, чем 3.0. 

Плата приемника и плата питания должны быть загружены программным 
обеспечением из одного пакета. Программное обеспечение модуля 
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Bluetooth не зависит от платы приемника и платы питания и входит в 
другой пакет встроенных программ. 
Для загрузки программного обеспечения плат спутникового приемника и 
питания используется программа FLoader, функционирующая в среде 
Windows. Более подробно эта программа описана в “Руководстве 
пользователя FLoader”. Запросите поставщика оборудования для 
получения программы и описания. В разделе “Установка программы 
FLoader” на стр. 2-6 подробно описывается процесс установки Floader на 
компьютер. 
1. Получите новый пакет встроенного программного обеспечения в 

службе технической поддержки и скопируйте его в компьютер. 
2. Установите соединение между приемником и компьютером (подробнее 

см. раздел “Подключение приемника к компьютеру” на стр. 2-19). 
3. Запустите программу FLoader. 
4. Во вкладке Connection (Соединение) выберите последовательный порт 

на компьютере, к которому подстыкован кабель связи с приемником и 
выберите скорость передачи данных (обычно 115200 Бод), см. рис. 
5-18 на стр. 5-17. 

5. Далее действуйте в соответствии с указаниями раздела "Загрузка 
встроенного программного обеспечения приемника и платы питания" 
на стр. 5-18. 

 
Рисунок 5-18. Главное окно FLoader 
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Загрузка встроенного 
программного обеспечения 
приемника и платы питания 
Программное обеспечение платы приемника и платы питания 
распространяется в виде архивного файла, который следует распаковать 
перед загрузкой в приемник. Этот файл содержит следующие три файла: 

• ramimage.ldr – файл-образ ОЗУ платы приемника 
• main.ldp – файл-образ флэш-памяти платы приемника 
• powrbrd.ldr – файл-образ ОЗУ платы питания 

При загрузке нового программного обеспечения Вы 
должны загрузить все три файла. Эти файлы должны 
быть взяты из одного пакета программного 
обеспечения. 

1. В программе FLoader выберите вкладку Device (Устройство), в ней 
для поля Device Type (Тип устройства) выберите значение Receiver 
(Приемник). После этого щелкните на кнопке Get from Device 
(Опросить устройство) для получения сведений об устройстве, см. 
рис. 5-19.  

 
Рисунок 5-19. Установка типа устройства приемника 

2. Выберите вкладку Program (Программа) и выберите значение Soft 
Break Capture для поля Capture Method, см. рис. 5-20. 
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Рисунок 5-20. Вкладка Program 

3. Выберите файлы для ОЗУ и флэш-памяти платы приемника, см. рис. 
5-20. 

4. Щелкните на кнопке Load (Загрузить) и подождите, пока файлы не 
будут загружены в приемник полностью. 

Если Вы выбрали неправильный файл, в нижней 
части диалогового окна появится сообщение об 
ошибке. Выберите правильный файл. 

5. Выберите вкладку Device, в ней выберите значение Receiver’s Power 
Board (Плата питания приемника) для поля Device Type (Тип 
устройства). После этого щелкните на кнопке Get from Device 
(Опросить устройство) для получения сведений об устройстве, см. 
рис. 5-21.  

 
Рисунок 5-21. Установите тип устройства Receiver’s Power Board 
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6. Выберите вкладку Program (Программа) и выберите значение Soft 
Break Capture для поля Capture Method, см. рис. 5-22. 

 
Рисунок 5-22. Вкладка Program 

7. Выберите файл для ОЗУ платы питания см. рис. 5-22. 
8. Щелкните на кнопке Load (Загрузить) и подождите, пока файл не 

будет загружен в приемник полностью. 

Если Вы выбрали неправильный файл, в нижней 
части диалогового окна появится сообщение об 
ошибке. Выберите правильный файл. 

9. Выберите пункт меню File > Exit (Файл > Выход). 
10. Очистите энергонезависимую память (см. раздел “Очистка 

энергонезависимой памяти (NVRAM)” на стр. 5-13) и обновите 
альманах (см. раздел “Сбор альманахов и эфемерид” на стр. 2-26).



 

P/N 7010-0736 6-1 

Глава 6  
Устранение 
неисправностей 
Эта глава поможет Вам определить причину некоторых отказов, которые 
могут возникнуть при работе приемника, и устранить их. 

 

Никогда не пытайтесь ремонтировать приемник 
самостоятельно. Нарушение этого требования 
лишает Вас гарантийного обслуживания и может 
привести к повреждению прибора. 

Проверьте прежде всего! 
При обнаружении отказов просим Вас до обращения в службу технической 
поддержки Topcon выполнить следующее: 

• Во-первых, тщательно проверьте все соединения приемника с 
внешними устройствами, чтобы убедиться в их правильности и 
надежности. Обратите особое внимание на исправность кабелей. 

• Проверьте заряд батарей всех источников питания и правильность 
подключения кабелей и батарей. 

• Убедитесь, что в приемник установлено самое последнее 
программное обеспечение. Запросите у поставщика наличие 
обновлений. 

• При соединении через Bluetooth, проверьте, что используемый для 
этого порт функционирует в режиме Command mode (Режим 
управления). 

После чего проделайте следующее: 
• Проведите перезагрузку приемника с помощью PC-CDU, пункт меню 

Tools > Reset receiver (Инструменты > Перезагрузка приемника). 
• Используя PC-CDU, восстановите начальные заводские установки 

(выберите пункт меню Configuration > Receiver (Настройка > 
Приемник)), в появившемся окне щелкните на кнопке Set all 
parameters to defaults (Принять начальные значения для всех 
параметров). 

• Очистите энергонезависимое ОЗУ (см. раздел “Очистка 
энергонезависимой памяти” на стр. 5-13). 

• Проведите инициализацию файловой системы - выберите пункт 
меню Tools > Initialize file system (Инструменты > Инициализация 
файловой системы). Это действие удаляет все файлы с 
измерениями, содержащимися в приемнике. 
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Если после выполнения этих действий проблема остается 
неразрешенной, обратитесь к следующим ниже разделам 

Список отказов приемника 
Отказы системы питания прибора: 

"Прибор не включается" см. стр. 6-3. 
“Невозможно установить соединение с компьютером или внешним 
контроллером” см. стр. 6-4. 

Отказы спутникового приемника. 
"Слежение за сигналом спутников не устанавливается в течение 
длительного промежутка времени" см. стр. 6-4. 
“Отслеживается малое количество спутников” см. стр. 6-5. 
“Нет местоопределения кодового DGPS или RTK” см. стр. 6-5. 
“Запись данных не производится” см. стр. 6-8. 

Отказы канала связи Bluetooth. 
"Сообщение программы BTCONF: Can’t find receiver (Приемник не 
обнаружен" см. стр. 6-9. 
"Сообщение программы BTCONF: Can’t find Bluetooth (Не обнаружен 
Bluetooth)" см. стр. 6-10. 
"Сообщение программы BTCONF: Open COM# port failed: Access is 
denied (Невозможно открыть порт COM# - в доступе отказано)" см. 
стр. 6-11. 
"В процессе поиска устройства не обнаружены" см. стр. 6-11. 
"Пиктограмма модуля Bluetooth приемника отображается на экране 
компьютера, но соединение с ним установить невозможно" см. стр. 
6-11. 

Отказы программы Modem-TPS. 
“Программа Modem-TPS не может установить соединение с 
приемником” см. стр. 6-12. 
“Индикация отказов светодиодом TX RX” см. стр. 6-13.
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Отказы системы питания 
Заводской установкой режима работы обеих батарей является Auto 
(Автоматический). Для того чтобы проверить этот параметр, проделайте 
следующее: 
1. Запустите программу PC-CDU и установите соединение между 

приемником и компьютером (подробнее см. раздел “Подключение 
приемника к компьютеру” на стр. 2-19). 

2. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник). 

3. Во вкладке General проверьте установки областей Power (Питание) и 
Charger (Зарядное устройство). В них должна быть выбрана 
установка Auto. Если это не так, измените их на Auto и щелкните на 
кнопке Apply (Применить). 

  

Очистка энергонезависимого ОЗУ вернет приемник к 
режиму AUTO (см раздел “Очистка 
энергонезависимой памяти (NVRAM)” на стр. 5-13). 

Прибор не включается. 
⇒ Съемные батареи могли быть неправильно установлены. 

• Проверьте правильность установки батарей. 
• Проверьте чистоту контактов батарей (расположены вверху 

батарейного отсека). 
⇒ Батареи могут быть разряжены 

• Подключите полностью заряженную батарею и попробуйте 
включить приемник повторно. См. раздел “Питание приемника” 
на стр. 2-14. 

• Оставьте батареи заряжаться на всю ночь. См. раздел “Питание 
приемника” на стр. 2-14. 

⇒ При использовании внешнего источника питания кабель мог 
отсоединиться или повредиться. 

Проверьте, подключен ли кабель правильно и не поврежден ли 
он. 

⇒ Встроенное в приемник зарядное устройство или батареи могли 
отказать. 

Если после замены батарей или подсоединения внешнего 
источника питания приемник не включается, обратитесь в службу 
технической поддержки TPS.
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Отказы спутникового 
приемника. 
Из тех отказов спутникового приемника относительно часто встречаются 
следующие: 
Невозможно установить соединение с компьютером или внешним 
контроллером 
Отказы кабельных соединений. 
⇒ Кабель подсоединен неправильно. 

• Проверьте, к нужному ли порту подсоединен ли кабель. 
• Расстыкуйте кабель, после чего вставьте его в разъемы 

повторно. 
• Разъемы на приборе описываются в разделах “Приемник GR-5” 

на стр. 1-10 и "Технические характеристики разъемов” на стр. A-
11. 

⇒ Кабель поврежден. 
• Используйте исправный кабель. Свяжитесь с поставщиком 

оборудования для замены кабеля. 
Отказы общего характера. 
⇒ Используемый для соединения порт приемника не находится в 

командном режиме (Command mode). 
1. Установите соединение компьютера с приемником, используя 

один из свободных портов (подробнее см. раздел “Подключение 
приемника к компьютеру” на стр. 2-19). 

2. Выберите пункт меню Configuration > Receiver > Ports 
(Настройка > Приемник > Порты). 

3. Задайте в поле Input (Режим ввода) значение Command 
(Командный). 

Слежение за сигналом спутников не устанавливается в течение 
длительного промежутка времени. 
⇒ В приемнике сохранен устаревший альманах. 

Обновите альманах. Подробнее см. раздел “Сбор альманахов и 
эфемерид” на стр. 2-26. 

⇒ Соответствующая опция приемника отключена или время ее 
использования закончилось (для слежения за спутниками L1/L2, 
GPS/GLONASS должны быть разрешены к использованию). 
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• Порядок действий при проверке текущих опций приемника 
детально описан в разделе “Управление опциями приемника” на 
стр. 5-10. 

• Закажите новый OAF с нужными опциями (разрешенными без 
ограничения по времени или с продленным сроком 
использования). Обратитесь к поставщику оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 

Отслеживается малое количество спутников. 
⇒ Значение предельного угла возвышения слишком велико (более 15 

градусов). 
Уменьшите значение предельного угла возвышения, процедура 
описана на стр. 3-15. 

⇒ Съемка производится вблизи препятствий (кроны деревьев, высокие 
здания и т.п.). 
• Проверьте использование алгоритмов подавления 

многолучевости. 
1. Запустите программу PC-CDU и установите соединение 

между приемником и компьютером (подробнее см. раздел 
“Подключение приемника к компьютеру” на стр. 2-19). 

2. Выберите пункт меню Configuration > Advanced (Настройка 
> Расширенные функции), затем вкладку Multipath 
Reduction (Подавление многолучевости), выставьте оба 
флажки и щелкните на кнопке Apply (Применить). 

• При возможности продолжите выполнение работ на большем 
удалении от препятствий. 

Нет местоопределения кодового DGPS или RTK. 
⇒ В базовую станцию введены неправильные координаты. 

Введите правильные координаты в базовую станцию, используя PC-
CDU или программное обеспечение полевого сбора данных. 

⇒ Приемник не настроен в качестве базового или подвижного. 
Если приемник должен использоваться в качестве базового, 
настройте его соответствующим образом. См. главу 3. 
Если приемник должен использоваться в качестве подвижного, 
настройте его соответствующим образом. См. главу 3.
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⇒ Соответствующая опция приемника отключена или время ее 
использования закончилось. 
• Порядок действий при проверке текущих опций приемника 

детально описан в разделе “Управление опциями приемника” на 
стр. 5-10. 

• Закажите новый OAF с нужными опциями (разрешенными или с 
продленным сроком использования). Обратитесь к поставщику 
оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 

⇒ На базовом и подвижном приемниках наблюдается недостаточное 
количество общих спутников. Для решения с разрешением фазовой 
неоднозначности до целых величин должны наблюдаться, по крайней 
мере, пять общих спутников. 
• Обеспечьте использование обеими приемниками одинакового и 

самого последнего альманаха. Подробнее см. раздел “Сбор 
альманахов и эфемерид” на стр. 2-26. 

• Проверьте значение предельного угла возвышения на базовом и 
подвижном приемниках - его следует установить одинаковым. 
Процедура установки значения предельного угла возвышения 
описана на стр. 3-15. 

⇒ На базовой станции и подвижном приемнике используются разные 
форматы дифференциальных поправок. 
Обеспечьте использование обоими приемниками одинакового 
формата дифференциальных поправок: 
1. Запустите программу PC-CDU и установите соединение между 

приемником и компьютером (подробнее см. раздел 
“Подключение приемника к компьютеру” на стр. 2-19). 

2. Выберите пункт меню Configuration > Receiver (Настройка > 
Приемник), затем вкладку Ports (Порты). Используйте для 
обоих приемников одинаковый формат дифференциальных 
поправок. 

⇒ Значение геометрического фактора слишком высоко, взаимное 
положение наблюдаемых спутников неблагоприятно для 
производства измерений. 
Продолжите работы тогда, когда значение геометрического фактора 
уменьшится.
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⇒ Значение предельного угла возвышения более 15 градусов. 
Уменьшите значение предельного угла возвышения, процедура 
описана на стр. 3-15. 

⇒ Батарея модема разрядилась. 
• Подключите к приемнику внешний источник питания. См. раздел 

“Использование дополнительных источников питания” на стр. 2-
17. 

• См. также раздел “Питание приемника” на стр. 2-14. 
⇒ Приемная или передающая антенны могут быть подсоединены 

неправильно. 
• Проверьте правильность подключения антенны радиомодема к 

соответствующему разъему. 
• Проверьте исправность антенны радиомодема. Если она 

неисправна, обратитесь к поставщику оборудования. 
⇒ Используемая скорость интерфейса последовательного порта 

спутникового приемника не совпадает со скоростью, установленной 
для последовательного порта платы радиомодема. 
Установите для интерфейса последовательного порта спутникового 
приемника скорость, поддерживаемую последовательным портом 
платы радиомодема. Подробнее см. описание модема. 

⇒ Радиомодемы базового и подвижного приемника используют разные 
параметры радиоканала. 
Настройте радиомодемы базового и подвижного приемника согласно 
установленного для них порядка. 
• Радиомодем FH915+ описывается в разделе “Настройка 

радиомодема” на стр. 3-3. 
• Модуль GSM модема описывается в разделе “Настройка 

радиомодема” на стр. .3-6. 
⇒ Расстояние между базовым и подвижным приемниками слишком 

велико. 
• Сократите расстояние между базовым и подвижным 

приемниками. 
• Для увеличения зоны радиопокрытия используйте репитеры.
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⇒ Функционированию канала связи мешает источник радиопомех. 
• Измените, по возможности, используемый канал. 
• С помощью спектроанализатора попробуйте определить 

характеристики помехи и перенастроить свой радиоканал. 
• Устраните источник помехи или переместите (по возможности) 

антенны радиомодемов. 
Запись данных не производится. 
⇒ Карта памяти формата SD не установлена в приемник, или опция 

записи в память отсутствует (время ее использования закончилось). 
• Проверите правильность установки SD карты. Подробнее см. 

раздел “Установка SD и SIM карт” на стр. 2-7. 
• Проверьте наличие опции записи в память (memory option). 

Порядок действий при проверке текущих опций приемника 
детально описан в разделе “Управление опциями приемника” на 
стр. 5-10. 

⇒ На карте памяти SD не осталось свободного места. 
• Выгрузите записанные файлы измерений в компьютер и сотрите 

их из памяти приемника для того, чтобы освободить место для 
новых файлов (см. разделы “Копирование файлов в компьютер” 
на стр. 5-1 и “Удаление файлов с SD карты приемника” на стр. 5-
8). 

• Разрешите использование режима ARFM (см. раздел 
“Параметры Automatic File Rotation Mode (AFRM) (Режим 
автоматического создания файлов)“ на стр. 3-23).
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Отказы канала связи 
Bluetooth. 
Ниже описаны наиболее часто встречающиеся отказы и сообщения об 
ошибках. 
Сообщение программы BTCONF: Can’t find receiver (Приемник не 
обнаружен). 
⇒ Приемник выключен. 

Убедитесь в том, что на приемник подано напряжение питания и он 
включен. 

⇒ Если используется кабель, его разъемы не подключены. 
• Проверьте, к нужному ли порту подсоединен ли кабель. 
• Расстыкуйте кабель, после чего вставьте его в разъемы 

повторно. 
⇒ Если используется кабель, он может быть поврежден. 

• Используйте исправный кабель.  
• Свяжитесь с поставщиком оборудования для приобретения 

нового кабеля. 
⇒ Последовательный (COM) порт, который используется приемником, 

не совпадает с выбранным в программе BTCONF. 
• Убедитесь в том, что кабель RS232 подсоединен к порту, 

указанному в списке последовательных портов программы 
BTCONF. 

• См. также раздел “Беспроводное соединение” на стр. 2-20. 
⇒ Используемый для соединения порт приемника не находится в 

командном режиме (Command mode). 
1. Установите соединение компьютера с приемником, используя 

один из свободных портов (подробнее см. раздел “Подключение 
приемника к компьютеру” на стр. 2-19). 

2. Выберите пункт меню Configuration > Receiver > Ports 
(Настройка > Приемник > Порты). 

3. Задайте в поле Input (Режим ввода) значение Command 
(Командный). 

  

Это является наиболее вероятной причиной 
появления указанного сообщения. Используйте 
программу PC-CDU для проверки настроек 
последовательного порта. 
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⇒ Возможно, изменились установки порта D. 
• Настройки порта D по умолчанию: 115200, 8, N, 1, квитирование 

не используется. 
• Попробуйте для порта D разрешить квитирование сигналами 

RTS/CTS. Прочие установки не изменяйте. 
⇒ Соответствующая опция приемника отключена или время ее 

использования закончилось (должно быть разрешено использование 
порта D). 
• Порядок действий при проверке текущих опций приемника 

детально описан в разделе “Управление опциями приемника” на 
стр. 5-10. 

• Закажите новый OAF с нужными опциями (разрешенными или с 
продленным сроком использования). Обратитесь к поставщику 
оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 

Сообщение программы BTCONF: Can’t find Bluetooth (Не обнаружен 
Bluetooth). 
⇒ Выключен слот 2(С) (внутренний разъем) прибора. 

1. Подключите приемник к компьютеру с помощью кабеля RS232, 
подробнее см. раздел “Соединение кабелем RS232” на стр. 2-21. 

2. Выберите пункт меню Configuration > Receiver > General 
(Настройка > Приемник > Общие установки). 

3. В области Turn on/off (включение/выключение) выставьте 
флажок Slot 2 (С). 

⇒ Модуль Bluetooth занят, поддерживая соединение с другим 
устройством. 
Закройте соединение, установленное с другим устройством, после 
чего установите новое. 

⇒ Прибор не оснащен модулем Bluetooth. 
• Продолжите работу, используя кабели последовательного 

интерфейса или USB. 
• Закажите у поставщика оборудования приемник, оснащенный 

модулем Bluetooth. 
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Сообщение программы BTCONF: Open COM# port failed: Access is 
denied (Невозможно открыть порт COM# - в доступе отказано). 
⇒ Порт, по которому должно осуществляться соединение, используется 

другой программой. 
• Закройте мешающую программу, после чего установите 

соединение. 
• Установите соединение через свободный последовательный 

порт. 
В процессе поиска устройства не обнаружены. 
⇒ Питание на приемник не подается. 

• Убедитесь в том, что на приемник подается напряжение питания, 
и он включен. 

• Убедитесь в том, что кабель питания подключен к разъему, 
маркированному “PWR”. 

• Расстыкуйте кабель питания, после чего вставьте его в разъемы 
повторно. 

• Если кабель поврежден, свяжитесь с поставщиком оборудования 
для приобретения нового кабеля. 

⇒ Выключен слот 2(С) (внутренний разъем) прибора. 
1. Подключите приемник к компьютеру с помощью кабеля RS232, 

подробнее см. раздел “Соединение кабелем RS232” на стр. 2-21. 
2. Выберите пункт меню Configuration > Receiver > General 

(Настройка > Приемник > Общие установки). 
3. В области Turn on/off (включение/выключение) выставьте 

флажок Slot 2 (С). 
Пиктограмма модуля Bluetooth приемника отображается на экране 
компьютера, но соединение с ним установить невозможно. 
⇒ Вероятно несовпадение параметров безопасности устройств. 

• Убедитесь в том, что на приемник подается напряжение питания 
и он включен. 

• Перед настройкой параметров безопасности ознакомьтесь с 
разделом “Настройка модуля Bluetooth” на стр. 2-22, особое 
внимание обратите на рис. 2-23 на стр. 2-25. 
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⇒ Возможно, изменились настройки модуля Bluetooth. 
• Если Вы изменяли настройки модуля Bluetooth, удалите его из 

списка обнаруженных устройств Bluetooth, используя программу 
управления, поставляемую в составе устройства, с которым 
производится соединение. 

• Проведите поиск повторно. 

Отказы программы Modem-
TPS 
Ниже описывается наиболее часто встречающийся отказ программы 
Modem-TPS. 
Программа Modem-TPS не может установить соединение с 
приемником. 
⇒ Приемник выключен. 

Убедитесь в том, что на приемник подано напряжение питания, и он 
включен. 

⇒ Если используется кабель, его разъемы не подключены. 
• Проверьте, к нужному ли порту подсоединен ли кабель. 
• Расстыкуйте кабель, после чего вставьте его в разъемы 

повторно. 
⇒ Если используется кабель, он может быть поврежден. 

• Используйте исправный кабель.  
• Свяжитесь с поставщиком оборудования для приобретения 

нового кабеля. 
⇒ Если используется канал связи Bluetooth, для установления связи 

выбран неправильный порт, или компьютер не поддерживает этот 
канал связи. 
• Примените компьютер (или приемник), оснащенные 

функционирующим каналом Bluetooth. 
• Проверьте правильность выбора портов связи компьютера и 

приемника. Для приемника GR-5 должен применяться порт A. 
⇒ Опция модема отключена или время ее использования закончилось. 

• Порядок действий при проверке текущих опций приемника 
детально описан в разделе “Управление опциями приемника” на 
стр. 5-10.
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• Закажите новый OAF с нужными опциями (разрешенными или с 
продленным сроком использования). Обратитесь к поставщику 
оборудования. 

• Опции подробно описываются в Руководстве пользователя PC-
CDU. 

⇒ Применяемый тип радиомодема не разрешен для обнаружения 
программой Modem-TPS.  

1. При необходимости щелкните на кнопке Cancel (Закончить) 
диалогового окна Connection (Соединение) или кнопке Stop 
(Останов) диалогового окна Connecting to device (Соединение 
c устройством). 

2. В программе Modem-TPS выберите пункт меню Tools > Options 
(Инструменты > Настройки). 

3. Разрешите использование радиомодема, которым оснащен 
прибор. 

4. Выберите пункт меню File > Connect (Файл > Соединить). 

Индикация отказов 
светодиодом TX RX 
Для встроенного модема FH915+: красные вспышки светодиода TX 
RX 
⇒ Обнаружен отказ. 

• Проверьте исправность антенны радиомодема. Если она 
неисправна, обратитесь к поставщику оборудования. 

• Проверьте правильность подключения антенны радиомодема к 
соответствующему разъему. 

• Переместите антенну (приемник) от проводящих объектов 
(например, металлических сооружений). 

⇒ Кабель поврежден. 
• Используйте исправный кабель. 
• Обратитесь к поставщику оборудования для приобретения 

нового кабеля. 
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Для встроенного модема GSM: оранжевые вспышки светодиода TX 
RX 
⇒ Подвижный приемник пытается использовать неправильный PIN-код, 

или PIN-код не введен. 
1. В программе TopSURV выберите пункт меню Job > Config 

>Survey (Проект > Настройка > Съемка). 
2. Щелкните на кнопке “…” (Продолжить), после чего щелкните на 

кнопке Next (Следующий) и используйте диалоговое окно Rover 
Radio (Радиоканал подвижного приемника). 

3. Щелкните на кнопке Configure GSM (Настройка GSM). 
4. Введите PIN-код и щелкните на кнопке OK. 

⇒ Произошла ошибка инициализации прибора. 
• Проверьте исправность антенны радиомодема. Если она 

неисправна, обратитесь к поставщику оборудования. 
• Проверьте правильность подключения антенны радиомодема к 

разъему, расположенному на обтекателе в верхней части 
прибора. 

Получение технической 
поддержки 
Если советы и рекомендации, приведенные в данном Руководстве 
пользователя, не помогли устранить ошибку, обратитесь за помощью в 
службу технической поддержки TPS.. 
Просим Вас сначала ознакомиться с разделом "Проверьте прежде всего!" 
на стр. 6-1, что позволит Вам устранить некоторые отказы 
самостоятельно. 

Телефон 
Чтобы связаться со службой технической поддержки TPS по телефону, 
звоните в США: 

1-866-4TOPCON (1-866-486-7266) 
С понедельника по пятницу с 16.00 до 4.00 утра по московскому 
времени. 
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Электронная почта 
Для контакта со службой технической поддержки TPS используйте один из 
следующих адресов электронной почты (Таблица 4-1). 

Таблица 6-1. Адреса электронной почты службы технической поддержки 

Для вопросов, связанных с… Используйте… 
Оборудованием (приемники, антеннами, проч.) Hardware@topcon.com 
GMS+ и 3DMC Psg@topcon.com 
Авторизацией опций Options@topcon.com 
Работой в режиме RTK Rtk@topcon.com 
PC-CDU Pccdu@topcon.com 
Если затрудняетесь определить тему Support@topcon.com 

 
 

  

Чтобы получить как можно более быструю и 
эффективную поддержку, предоставьте, пожалуйста, 
сведения, перечисленные ниже. 

1. Модель устройства и его конфигурацию.  
Для этого в программе CE-CDU выберите пункт меню File > Receiver 
Info (Файл > Данные о приемнике) и щелкните на кнопке Save to file 
(Сохранить в файл). Введите имя файла и перенесите его в 
персональный компьютер. Вложите этот файл в письмо. 

2. Серийный номер Вашего прибора (нанесен на шильдике под 
батареей). 

3. Сведения о системе и узлах прибора: версия операционной системы, 
размер оперативной и постоянной памяти, скорость процессора и т.д. 

4. Внешние проявления отказа (или сообщения, отображаемые на 
экране) до или после ошибки. 

5. Действия, которые Вы предприняли для устранения отказа. Если это, 
возможно, опишите все, что Вы делали, по шагам, до того момента, 
когда появляется сообщение об ошибке или иной отказ. 

6. Насколько часто проявляется отказ. 
В большинстве случаев представитель службы технической поддержки 
отвечает в течение 24 часов после получения письма, в зависимости от 
сложности отказа. 
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Интернет-сайт 
На сайте Topcon Positioning Systems содержится регулярно обновляемая 
информация о продукции фирмы. В разделе технической поддержки 
имеются ответы на часто задаваемые вопросы, процедуры настройки, 
инструкции к приборам, технической поддержки и т.п. 

Адрес интернет-сайта TPS: www.topconpositioning.com 
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Приложение A 
Технические 
характеристики 
Это изделие производства фирмы TPS является 216 канальным 
приемником спутниковых навигационных систем (ГНСС) со встроенным 
радиомодемом, модулем беспроводного канала передачи данных 
Bluetooth, (заказываемом опционально) радиомодемом GSM, 
(заказываемой опционально) сменной картой памяти формата SD. Прибор 
выполнен в защищенном от внешних воздействий магниевом корпусе, 
оснащенном пользовательским интерфейсом MINTER и разъемами 
внешних соединителей. 

Эксплуатационные характеристики даны для 
следующих условий наблюдения: приемник 
отслеживает не менее 6 спутников GPS на углах 
возвышения не менее 15 градусов, выполнены все 
рекомендованные в этом руководстве процедуры. 

 
Допускается ухудшение эксплуатационных 
характеристик в условиях высокой многолучевости, 
при высоком значении геометрического фактора 
(PDOP), а также в периоды повышенной 
ионосферной активности. 

 
Используйте дополнительные процедуры контроля 
качества измерений при производстве работ в 
условиях высокой многолучевости и под густой 
листвой. 
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Характеристики приемника 
Ниже  приводятся  характеристики  приемника  и его встроенных  узлов . 

Общие характеристики GR-5 
В  таблице  А-1 приведены  основные  характеристики  приемника . 

Таблица А-1. Основные характеристики приемника 

Конструктивное исполнение. 

Корпус . Магниевый  сплав , защита  от влаги  IP Х 6. 

Цвет . Желтый  и серый  цвета  фирмы  Topcon. 

Габариты  [мм]. Ширина  – 158,0, Длина :158,1, Высота : 253,0 

Масса  [кг]. 1.88 (с батареями), 1.44 (без батарей) 

Антенна . Встроенная . 

Батареи . Две  внешние  отстыковываемые . 

Контроллер . Внешний . 

Крепление . Втулка  с резьбой  5/8-11, разъем  быстрого  
подсоединения . 

Уплотнение . Силиконовая  резина . 

Кнопки ( клавиши ). 

Две  клавиши : 
Питания  – Вкл ./Выкл . 
FUNCTION – используется  для  начала  и 
окончания  процесса  записи  данных ; 
переключения  информационного  режима  
приемника . 

Светодиоды . 

Шесть  светодиодов : 
STAT – состояние  спутников  и приемника . 
REC – состояние  записи  и данных . 
RX TX – состояние  модема  
BT – отображает  состояние  соединения  

Bluetooth. 
BATT (2 шт )– состояние  батарей . 

Устойчивость к внешним воздействиям. 

Рабочая  температура . от -40°С до +70°С
от -30°С до +60°С со встроенными батареями
от 0°С до +45°С в режиме зарядки с батареями
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Температура  хранения  от -20 до +35 градусов  Цельсия  с батареями . 
от -40 до +75 градусов  Цельсия  без  батарей . 

Влажность . 95% 

Электропитание. 

Внешние  батареи . Li-ion ( Литий -ионные ), 3900 мА-ч, 7.2 В ; 
отстыковываемые . 

Габариты  батареи  [мм]. 133 x 55 x 35 

  

Масса  батареи  [кг] 0.220 
Время  работы  
 
Средние  величины  при 
включенном  модуле  
Bluetooth и слежением  за  
12- ю спутниками . 
 
Используются  новые  
батареи .  
 
Температура  окружающей  
среды  – комнатная . 

• Модем  выключен  – примерно 20 часов . 
• Радиомодем  915 – режим приема  - примерно 

14 часов . 
• Радиомодем  915 – передача  250 мВт  - 

примерно 12 часов . 
• Радиомодем  915 – передача  1 Вт  - примерно 10 

10 часов. 
• Если  питание  обеспечивается  батареями  типа  

AA, вставленными  в два  отсека , модем  
выключен  – примерно 2.5 часа . 

• В  условиях  городской застройки  с плотной  
сетью  сотовых  станций , с включенным  
модулем  GSM/GPRS - примерно 13 часов  с 
непрерывным  соединением . 

Внешнее  питание . 1 разъем . 

Входное  напряжение . От  9 до 21 ( Вольт  пост . тока) для  работы . 
от 10 до 21 ( Вольт  пост . тока) для  зарядки  
батареи . 
Ток зарядки  ( максимальный ) – 2 А. 

Потребляемая  мощность .  
Средняя  величина  при 
включенном  модуле  
Bluetooth и слежением  за  
12- ю спутниками . 
 

• Модем  выключен  – примерно 2.5 Вт . 
• Радиомодем  915 – режим приема  - примерно 

3.4 Вт . 
• Радиомодем  915 – передача  250 мВт  – 5.0 Вт . 
• Радиомодем  915 – передача  1 Вт  – 6.0 Вт . 

Зарядное  устройство . Чтобы  зарядить  батарею , подключите  адаптер  
переменного  тока. 
Зарядка  возможна  при подключении  к 
портативному  внешнему  источнику  питания . 

Время  зарядки . Полная  зарядка  занимает  приблизительно  6 
часов . 

Встроенный  источник. Резервная  батарея  для  поддержки  встроенных  
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часов ; срок службы  ( минимальный ) – 10 лет . 

Ввод / вывод 

Порты  передачи  данных  
Высокоскоростной  порт RS-232 ( черный  ободок), 
порт USB ( желтый  ободок) и встроенный  модуль  
Bluetooth ( порт D). 

Характеристики  портов. 

Последовательный  порт RS-232 
Скорость  передачи  данных  - 460800, 230400, 
115200( начальная  установка ), 38400, 19200, 9600, 
4800, 2400, 1200, 600, 300 
Квитирование  - RTC/CTS 
Размер  слова  - 7, 8 ( начальная  установка ) 
Стоп -биты  - 1 ( начальная  установка ), 2 
Четность  не проверяется  ( начальная  установка ), 
проверка на четность , проверка на нечетность . 
Порт  Bluetooth: в наличии . 
Порт  USB: Версии  1.1 

Разъемы . 
Антенны  радиомодема  (BNC или reverse polarity 
TNC в зависимости  от типа  модема ), порт 
внешнего  питания , RS-232, USB. 

Пользовательский  
интерфейс  MINTER. 

Шесть  светодиодов  ( подробнее  см. графу  
"Светодиоды " на стр.A-2), кнопка Питание  для  
включения  и выключения  питания , управление  
сбором  данных  производится  кнопкой FUNCTION. 

Характеристики и форматы данных. 

 

Темп  измерений  ( фаз  кода и несущей ) и 
местоопределений  до 100 Гц ; 
Точность  измерения  фазы  кода 10 см, фазы  
несущей  – 0.1 мм; 
Вход  и выход  данных  формата  RTCM версий  2.1, 
2.2, 2.3 и 3.0; 
Модели  геоида  и магнитного  поля ; 
RAIM ( автономный  мониторинг целостности ); 
Поддержка  разных  систем  координат ; 
Выдача  местоопределений  в координатах  
проекции; 
Поддержка  форматов  CMR и CMR+.  

Возможности измерительных каналов. 

 

Подавление  влияния  многолучевости ; 
Слежение  за  сигналами  спутников  WAAS; 
Настраиваемые  параметры  петель  слежения  за  
фазой  несущей  (PLL) и кодовой задержки  (DLL);  
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NMEA. 

Версия  протокола  Вывод  в соответствии  с 2.1, 2.2, 2.3 и 3.0 

Сообщения  GGA, GLL, GNS, GRS, GSA,  GST, GSV, HDT, RMC, 
VTG, ROT, GMP, 2DA, UID, P-ATT 

Интервал  выдачи  1 Гц  ( стандартно ); 5, 10, 20, 50 и 100 Гц  ( опция) 

DGPS. 
Формат  данных . RTCM 2.1, 2.2, 2.3 и 3.0. 

Типы  сообщений  RTCM. по  выбору  оператора

Темп  решения  
навигационной  задачи . 1 Гц  ( стандартно ); 5, 10, 20, 50 и 100 Гц (опция).  

Темп  выдачи  поправок

Предельный  угол места . От  0 до 90 градусов , не зависит  от аналогичного  
параметра  для  записи  данных . 

DGPS с использованием  
нескольких  базовых  
станций . 

Выбор  способа  использования  
дифференциальных  поправок: Nearest 
(Ближайшая ), Mix ( Смешанный ), Best ( Лучшая ) – 
опция. 

RTK. 

Формат  данных . CMR2/CMR+ ( совместим  с изделиями  ф . Trimble), 
RTCM SC104 версий  2.2, 2.3 и 3.0. 

Типы  сообщений  RTCM.    3, 18, 19, 20, 21, 22 по выбору  оператора . 

Разрешение  
неоднозначности . OTF (L1, L1/L2). 

Длина  базиса . До 50 км утром  и вечером . 
До 32 км в полдень . 

Время  инициализации . 
От  5 секунд  до 10 минут  в зависимости  от длины  
базовой  линии и условий  многолучевого  
распространения . 

Темп  выдачи  поправок 
формата  RTCM/CMR. 

Предельный  угол места . От  0 до 90 градусов , не зависит  от аналогичного  
параметра  для  записи  данных . 

Тип  решения . С  задержкой  ( синхронное ); 
Экстраполированное  ( а синхронное ). 

Темп  решения  
навигационной  задачи . 
Задержка  выдачи  
навигационного  решения . 

Режим  с задержкой  – от 20 мс до 20 с, зависит  от 
задержки , с которой принимаются  данные  от 

1, 3, 9, 31, 32, 34 

1 Гц  ( стандартно ); 5, 10, 20, 50 и 100 Гц (опция).  

1 Гц  ( стандартно ); 5, 10, 20, 50 и 100 Гц (опция).  

1 Гц  ( стандартно ); 5, 10, 20, 50 и 100 Гц (опция).  
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базового  приемника . 
Режим  с экстраполяцией  – от 2- до 30 мс. 

Запись  данных  измерений  

При работе  в режиме  RTK приемник способен  
записывать  данные  измерений  с темпом , не 
совпадающим  с темпом  решения  навигационной  
задачи . 

Данные  о состоянии . 

Тип  решения  (Fix, Float), геометрический  фактор , 
состояние  канала  связи , задержка  полученных  
данных , наблюдаемое  совместно  созвездие , 
относительное  количество  полных  решений . 

Результаты  
местоопределения . 

Координаты  и оценки их точности  ( с.к.о. 
горизонтальных  и вертикальной  координат ), 
ковариационная  матрица . 

Уровень  принятия  
решения  о разрешении  
фазовой  
неоднозначности . 

Выбираемый  уровень  
Низкий – 95%, Средний  – 99.5%, Высокий  – 99.9%. 

Режимы съемки. 

Базовый  или подвижный  
приемники. 

Статический ; 
Кинематический  с остановками ; 
RTK ( Кинематический  реального  времени ); 
DGPS ( дифференциальный  по кодовым  
измерениям ); 
WAAS/EGNOS DGPS. 

Точность съемки в режиме. 

Статический  ( в т.ч. 
“быстрый ”). 

для  L1+L2 – в плане : 3 мм + 0.5 мм/км 
по высоте : 5 мм + 0.5 мм/км 

Кинематический  с 
камеральной  обработкой , 
RTK 

для  L1+L2, L1 – в плане : 10 мм + 1.0 мм/км 
по высоте : 15 мм + 1.0 мм/км 

DGPS ( по измерениям  
фазы  кода) 

В  камеральной  обработке : с.к.о. горизонтальных  
координат  менее  0.25 м 
DGPS/RTCM ( в реальном  времени ): с.к.о. 
горизонтальных  координат  менее  0.25 м 

Время  местоопределения  

“Теплый” старт  
“Холодный” старт 
Восстановление слежения 

менее  10 с
менее  30 с
менее  60 с 

“Горячий” старт

менее  1 с
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Технические характеристики платы 
спутникового приемника. 
В  таблице  A-2 приведены  общие  характеристики  платы  спутникового  
приемника . 

Таблица A-2. Характеристики платы GPS 

Тип приемника (устанавливается загрузкой OAF). 

Внутренняя  плата : 
GR-5 

GPS: L1 C/A и  P – коды, L2, L2C, L5. 
ГЛОНАСC : L1, L2 ( кодовые  и фазовые  измерения ) 
GALILEO: Glove –A, Glova-B (E, E5a)
SBAS (WAAS/EGNOS/MSAS) L1 кодовые и фазовые измерения 

Тип  радиомодема  
(зависит  от страны)

FH915+ передача /прием/репитер  
FH915+ передача /прием/репитер  и GSM 

Характеристики слежения. 
еыньласревину,воланак 612ыланак еынтраднатС

Дополнительно    Cindrella days ( см. стр. А-8). 

Отслеживаемые 
сигналы

 GPS/ГЛОНАСС, L1/L2, C/A, L5, GALILEO: Glove –A, 
Glova-B (E, E5a), P-код и фаза несущей, WAAS/EGNOS, SBAS 
(WAAS/EGNOS/MSAS) L1 кодовые и фазовые измерения 

    

 

Функции слежения 

Подавление  
многолучевости . По коду и фазе  несущей . 

Настраиваемые  
параметры  PLL/DLL. Полоса  частот  и порядок фильтра . 

Интервал  сглаживания . Измерений  кода и фазы  несущей . 

WAAS/EGNOS WAAS ( опция) 
EGNOS ( опция) 

Типы и характеристики данных. 

Поддерживаемые  
форматы  данных . TPS, NMEA, RTCM , CMR, BINEX 

Характеристики . 

Темп  измерений  ( фаз  кода и несущей ) и 
местоопределений  до  100 Гц ; 
Точность  измерения  фазы  кода 10 см, фазы  
несущей  – 0.1 мм; 
Вход  и выход  данных  формата  RTCM версий  2.1, 
2.2, 2.3 и 3.0; 
Модели  геоида  и магнитного  поля ; 
RAIM ( автономный  мониторинг целостности ); 
Поддержка  разных  систем  координат ; 
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Выдача  местоопределений  в координатах  
проекции; 
Поддержка  форматов  CMR и  CMR+. 

Память. 

Внутренняя  память .             Cъемная  карта  памяти  формата  SDHC. 

Емкость  памяти . 
В  зависимости  от используемой  карты  SD/MMC 
(Secure Digital/Multi-Media Card), в настоящий  
момент  поддерживается  до 2 Гб . 

Продолжительность  
записи . 480 часа  (2 Гб , 1 Гц, L1/L2, 14 спутников ). 

Интервал  записи . От  0,05 до 86400 секунд , в зависимости  от 
приобретенных  опций. 

Cindrella days - опция, которая  превращает  одночастотный  GPS- приемник 
в двухчастотный  GPS+ ГЛОНАСС  приемник на 24 часа  каждый  вторник, 
начиная  с полуночи  по шкале  времени  GPS. За  более  подробной  
информацией  и конкретными  датами  дней  Cindrella обратитесь  к 
поставщику  оборудования  Topcon. 

Технические характеристики 
модуля Bluetooth приемника GR-5. 
В  таблице  A-3 приведены  общие  характеристики  модуля  беспроводной  
связи  Bluetooth. 

Таблица A-3. Характеристики модуля Bluetooth 

Дальность  работы . До 10 м в помещениях , до 20 м вне помещений . 

Тип . Класс  2  

Классы  обслуживания . Разнообразные . 

Поддерживаемые  
профили . LM, L2CAP, SDP, PPP. 

Код частоты  страны . Северная  Америка  и Европа . 
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Технические характеристики 
встроенного широкополосного 
радиомодема 
В таблице А-4 перечислены общие характеристики встроенного 
широкополосного радиомодема фирмы TPS. 

Таблица A-4. Характеристики встроенного широкополосного радиомодема 

Общие. 

Частотный диапазон 
(зависит от страны, 
региона и назначения 
прибора). 

902 – 928 МГц – США 
915 – 928 МГц – Австралия 

Структура сигнала. Широкополосный сигнал со скачкообразным 
изменением несущей частоты. 

Последовательность 
скачков. 

5 разновидностей на полосу, выбирается 
оператором. 

Количество каналов. 128 

Занимаемая полоса. 100 КГц 

Метод модуляции. FSK, 64 кбит/сек 

Усиление в тракте. 135 дБ 

Структура сети. Точка-точка, точка-многоточка 

Режим работы. Передатчик, приемник, репитер. 

Протокол обмена. FH915, FH915+ 

Передатчик. 

Мощность. 250 мВт (24 dBm) / 1 Вт (30 dBm) по выбору 
оператора. 

Приемник. 

Чувствительность. -105 dBm при достоверности 10-4 BER. 

Динамический диапазон. 105 dBm 
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Передача данных. 

Последовательный 
интерфейс. RS-232 

Скорость передачи 
данных по 
последовательному 
порту. 

9600, 19200, 38400 и 57600 бит/сек по выбору 
оператора. 

Скорость передачи 
данных по эфиру. 

9600, 10200, 17000, 51000 бит/сек по выбору 
оператора для FH915, автоматический выбор для 
FH915+. 

Алгоритм коррекции 
ошибок. Мажоритарное декодирование FEC(15,7)  

Антенна. 

Тип. Штыревая ½ длины волны шарнирная антенна. 

Разъем. Reverse polarity TNC. 

Усиление. 2.5 dBi. 

Технические характеристики 
опционального модуля GSM/GPRS 
В таблице А-5 перечислены внутренние общие характеристики 
опционально поставляемого встроенного модуля.  

Таблица A-5. Характеристики модуля GSM/GPRS  

Поддерживаемые 
стандарты. 

EGSM: 900/1800 МГц; 
GSM: 850/1900 МГц.  

ВЧ мощность передачи. 0,6 Вт (850 МГц); 2 Вт (900 МГц); 1 Вт (1800/1900 
МГц) 

GPRS. 

Мульти-слот класс 8 (4 down; 1 up); 
Максимальный BR 85,6 Кбит/сек; 
GSM 07.10 мультиплексный протокол класса В; 
Схема кодирования CS1-CS4; 

CSD. Максимальная скорость 14,4 Кбит/сек.  

SMS MO/MT текст  и PDU режимы  
Cell broadcast (прием служебного канала). 
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Технические характеристики 
разъемов 
GR-5 оборудован одним антенным разъемом для подключения 
радиомодема и тремя разъемами для обеспечения электропитания и 
обмена данными. 

ВЧ разъем радиомодема 
Разъем подключения модема описывается в таблице А-6. 

Таблица A-6. Характеристики модуля GSM/GPRS  

Модем Тип Сигнал Направл
ение Описание 

Широкополос
ный 

Reverse 
polarity TNC 

Вход/выход 
радиомодема 

Вход/ 
выход ВЧ/GSM антенна 

Порт питания 
Обозначенный ободком красного цвета, разъем питания (см. рис. А-1) -
герметичный пятиштырьковый гнездовой, производится фирмой ODU p/n 
G80F1C-T05QF00-0000. 

 
Рисунок А-1. Порт питания 

В таблице А-7 приведено описание разъема питания. 

Таблица А-7. Описание разъема питания 

Штырек Сигнал Направление Примечание 

1 Power_INP (Питание Силовой 9 - 21 Вольт 



Характеристики 

 GR-5. Руководство пользователя A-12 

Вход). постоянного тока 

2 Power_INP (Питание 
Вход). Силовой 9 - 21 Вольт 

постоянного тока 

3 Power_GND (Питание 
Общий). Силовой Общий 

4 Power_GND (Питание 
Общий). Силовой Общий 

5 Aux_GND (Питание 
Дополнительный). Силовой 9 - 21 Вольт 

постоянного тока 

Разъем последовательного порта 
RS-232 
Обозначенный ободком черного цвета, разъем RS232 (см. рис. А-2) - 
герметичный семиштырьковый гнездовой фирмы ODU p/n G80F1C-
T07QC00-0000. 

 
Рисунок А-2. Разъем RS232. 

В таблице А-8 приведено описание разъема RS232. 
Таблица А-8. Описание разъема RS232. 

Штырек Сигнал Направление Примечание 

1 Питание Выход  Силовой Выход напряжения 
питания 

2 Общий  Сигнальный общий. 

3 СTS Вход Передача возможна. 

4 RTS Выход Запрос на передачу. 

5 RXD  Вход Прием данных. 

6 TXD Выход Передача данных. 
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7   Не используется 
 

Разъем USB 
Обозначенный ободком желтого цвета, разъем интерфейса USB (см. рис. 
А-3) - герметичный четырехштырьковый гнездовой, соответствующий 
кабелю TPS. 

 
Рисунок А-3. Разъем USB 

В таблице А-9 приведено описание разъема USB. 

Таблица А-9. Описание разъема USB 

Штырек Сигнал Направление Примечание 

1 USB_PWR Силовой Шина питания USB 

2 GND   Земля 

3 USB D+ Вход/Выход Данные 

4 USB D- Вход/Выход Данные 
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Для заметок: 
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Приложение B 
Меры безопасности 
 

Предупреждения общего 
характера 

Санитарно-гигиенические нормы эксплуатации 
радиосредств выполняются на удалении более 25 см 
от антенны модуля GSM. 

 

 

Приемники TPS предназначены для геодезической 
съемки и относящихся к ней задач (например, 
определения координат, измерение расстояний, 
углов и глубин и записи результатов таких 
измерений). Эти изделия нельзя использовать: 
• Без тщательного изучения и четкого понимания 

этого Руководства. 
• После отключения систем безопасности или 

внесения  изменений в изделие. 
• С нештатными принадлежностями. 
• Без соблюдения соответствующих мер 

безопасности при проведении работ. 
• Вопреки установленным законам, нормам и 

правилам 
 

 

TPS приемники нельзя использовать в опасных 
окружающих условиях. Использование приемника под 
дождем и снегом допустимо лишь в течение 
ограниченного времени. 
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Безопасное использование 
батарей 
 

 

Ни в коем случае не пытайтесь вскрыть корпус 
сменной батареи! Литиевые батареи могут взорваться 
при неправильном обращении 

 

 

Ни в коем случае не сжигайте и не нагревайте 
батарею выше 100 градусов по Цельсию. Перегрев 
может вызвать серьезные повреждения и взрыв. 

 

 

Манипуляции со сменной батареей конечными 
пользователями или не уполномоченными 
производителем техниками приводит к потере 
гарантийных обязательств на батарею. 

• Не пытайтесь открыть батарейный блок или 
заменить его. 

• Не разбирайте батарейный блок. 
• Не производите зарядку батарей в условиях, 

отличных от указанных в Руководстве. 
• Не используйте зарядное устройство, отличное 

от указанного в Руководстве. 
• Избегайте короткого замыкания. 
• Не разрушайте и не изменяйте конструкцию. 
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Предупреждения по 
применению 
 

 

Если это изделие было подвергнуто ударному 
воздействию, модифицировано, перевозилось без 
надлежащей упаковки или с ним обращались без должной 
аккуратности, измерения могут содержать погрешности. 
 
Пользователь должен периодически поверять изделие 
для того, чтобы удостовериться в том, что точность 
проводимых им измерений соответствует заявленным 
техническим характеристикам.  
 
Немедленно информируйте TPS о неправильной работе 
изделия. 

 

 

Ремонт и обслуживание изделия должны проводиться 
исключительно в сервисных центрах, сертифицированных 
TPS 
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Для заметок: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

P/N 7010-0736 C-1 

Приложение C 
Нормативные 
сведения 
В этом приложении содержится информация о соответствии данного 
изделия официальным нормативным требованиям. 

Соответствие требованиям 
FCC 
Это устройство соответствует правилам FCC, Часть 15. Устройство в 
рабочем состоянии должно соответствовать следующим двум условиям: 
1. Данное устройство не должно вызывать вредных помех. 
2. Это устройство должно воспринимать любую помеху, включая помехи, 

которые могут вызвать нежелательные сбои в работе. 
Это оборудование было испытано и признано соответствующим по 
ограничениям для цифровых устройств класса В, в соответствии с 
правилами FCC, Часть 15. Эти ограничения предназначены для 
обеспечения обоснованной защиты от вредных помех при стационарной 
установке. Это оборудование генерирует, использует и может излучать 
электромагнитные волны в радиочастотном диапазоне, и, если 
устанавливается не в соответствии с инструкциями, может вызвать 
помехи для радиосвязи. Однако нет никакой гарантии в том, что вредные 
помехи не возникнут в каждом конкретном случае. 
Если это оборудование вызывает помехи для радио или телевизионного 
приема, что может быть установлено включением и выключением 
аппаратуры, пользователь может попытаться устранить наведенные 
помехи одним или несколькими перечисленными ниже способами: 

• Изменить ориентацию или местоположение принимающей антенны. 

• Переместить оборудование от приемника. 

• Запитать оборудование и приемник от разных сетевых розеток. 

• Проконсультируйтесь с продавцом оборудования или опытным 
радиотехником для получения конкретных рекомендаций. 
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Любые изменения или модификации, примененные к 
оборудованию без выраженного одобрения стороной, 
ответственной за соответствие этим требованиям, 
может аннулировать Ваше право на эксплуатацию 
этого оборудования. 

 

Соответствие требованиям 
стран Европейского 
содружества. 
Аппаратура, описанная в этом руководстве, соответствует нормативам 
R&TTE и EMC, принятым в странах Европейского Содружества. 

Директива WEEE 

 

Согласно директиве WEEE (WEEE - Waste Electrical and Electronic 
Equipment – директива ЕС по утилизации электрического и электронного 
оборудования) этот символ обозначает то, что данная аппаратура не 
может быть утилизирована как бытовые отходы. Правильным образом 
утилизировав это устройство, Вы поможете предотвратить вред 
окружающей среде и здоровью людей, который в противном случае будет 
вызван неправильной переработкой этого устройства. За более подробной 
информацией обращайтесь к продавцу этого оборудования.
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Приложение D 
Гарантийные 
обязательства 
Лазерные и электронные геодезические инструменты компании TPS 
гарантированы от использования дефектных материалов и 
работоспособны при эксплуатации согласно этому Руководству. Гарантия 
действительна в течение периода времени, указанного на гарантийном 
талоне (прилагается к изделию, приобретенному у авторизированного 
дилера TPS).1  
В течение гарантийного периода TPS, по своему выбору, бесплатно 
восстановит или заменит неисправное оборудование. Запасные части и 
изделия будут заменены новыми или отремонтированы на основании 
обмена на неисправное оборудование. Эта ограниченная гарантия не 
распространяется на услуги по восстановлению изделия, неисправного из-
за несчастного случая, стихийного бедствия, неправильной эксплуатации 
или несанкционированной модификации. 
Гарантийное обслуживание может быть получено от уполномоченного на 
производство ремонта представителя TPS. Если неисправное изделие 
поставляется почтой, покупатель обязуется застраховать изделие или 
принимает риск потери или повреждения во время транспортировки. При 
пересылке покупатель должен использовать оригинальную упаковку или 
эквивалентную. К направляемому в гарантийный ремонт изделию следует 
приложить письмо, описывающее отказ и/или дефект изделия. 
TPS ни при каких условиях не принимает на себя обязательств возмещать 
убытки или издержки, в том числе упущенную выгоду, потери денежных 
средств, или другие прямые или косвенные убытки, могущие возникнуть от 
использования или невозможности использования изделия. 
 
 
 
 

                                         
1 Гарантия на батареи, зарядные устройства и кабели производства 
Topcon составляет 90 дней. 
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Для заметок: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




